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Introduction 

Overview 
For an overview of the HP Workstation Blade Solution, including its architecture, HP recommends that you 
read the following documents available on the HP website (www.hp.com/support/WS460c_manuals 
(http://www.hp.com/support/ws460c_manuals)). 

• HP ProLiant Workstation Blades 

• HP Remote Graphics Software User Guide 

• HP Workstation Blade Client Series—Embedded OS Version 9.xx Manual 

• Administrator guides 

This Administrator Guide provides information for Microsoft® Windows® XP Pro SP2, Microsoft® 
Windows® XP Pro x64 Edition, and Windows Vista® (both 32-bit and 64-bit versions). 

 

Contacting HP technical support or an authorized 
reseller 

Before contacting HP, always attempt to resolve problems by completing the procedures in this guide. 
  

 IMPORTANT:  Collect the appropriate server information and operating system information 
before contacting HP for support. 

  

For the name of the nearest HP authorized reseller:  

• See the Contact HP worldwide (in English) webpage 
(http://welcome.hp.com/country/us/en/wwcontact.html). 

For HP technical support: 

• In the United States, for contact options see the Contact HP United States webpage 
(http://welcome.hp.com/country/us/en/contact_us.html). To contact HP by phone: 

o Call 1-800-HP-INVENT (1-800-474-6836). This service is available 24 hours a day, 7 days a 
week. For continuous quality improvement, calls may be recorded or monitored.  

o If you have purchased a Care Pack (service upgrade), call 1-800-633-3600. For more 
information about Care Packs, refer to the HP website (http://www.hp.com/hps). 

• In other locations, see the Contact HP worldwide (in English) webpage 
(http://welcome.hp.com/country/us/en/wwcontact.html). 

http://www.hp.com/support/ws460c_manuals�
http://welcome.hp.com/country/us/en/wwcontact.html�
http://welcome.hp.com/country/us/en/contact_us.html�
http://www.hp.com/hps�
http://welcome.hp.com/country/us/en/wwcontact.html�
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Workstation blade video subsystem 

WS460c video subsystem overview 
This chapter describes the workstation blade video subsystem. Because the workstation blade contains 
two types of video controllers, you must be familiar with their functionality and operating modes. 

• ATI RN50 video controller (ATI video controller)—The ATI Video controller is built into the 
workstation blade. 

• NVIDIA Quadro FX graphics adapter (NVIDIA graphics adapter)—The WS460c Workstation Blade 
supports NVIDIA graphics adapters in single-card and dual-card configurations. See Hardware and 
Software Supported by HP ProLiant Workstation Blades. 

HP offers the HP Graphics Expansion Blade (expansion blade), which attaches only to the workstation 
blade. The expansion blade supports the installation of certain PCI-Express NVIDIA Quadro FX graphics 
adapters. 

If an expansion blade is not attached to the workstation blade, NVIDIA graphics adapters are installed in 
the WS460c Workstation Blade. If an expansion blade is attached, graphics adapters can only be 
installed in the expansion blade, not in the workstation blade. Unless otherwise noted, no distinction is 
made in this chapter based on where the graphics adapters are installed internally to the WS460c 
Workstation Blade or in the expansion blade, because installation location is not visible to the Windows® 
operating system. 

 

Video subsystem architecture and operating modes 
The key features of the video subsystem are: 

• The workstation blade boot console is generated by the ATI video controller. The boot console can 
be viewed either by connecting a monitor to the video output of the Local I/O Connector or can be 
viewed over the network using the iLO 2 Ethernet port. 

• The Windows® desktop runs on the NVIDIA graphics adapter in User Mode only. 

• You can view the Windows® desktop on internally installed NVIDIA graphics adapters using RGS. 
You can view the video directly if he graphics connectors are present. 

• Operation of the workstation blade ATI video controller and NVIDIA graphics adapter is governed 
by the BIOS parameter Remote Console Mode, which can be set to the following modes: 

o User Mode (default setting) 

o Admin Mode 

o Server Mode 

o Setup Mode 

o HP Graphics Expansion x16 mode (only for WS460c Graphics Expansion Blade) 
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Setting Remote Console mode 
Remote Console Mode can be viewed or changed during POST, when the boot console is generated by 
the ATI video controller in all Remote Console modes. To view or set Remote Console Mode during 
booting: 

1. Using either the Local I/O Connector or the iLO 2 Ethernet port, view the boot console using iLO 2, 
which provides direct control of the workstation blade power. 

2. When prompted during booting, press the F9 key. The ROM-based Setup Utility appears. 

3. Select System Options > Remote Console Mode. The current Remote Console Mode appears. 

4. To change the Remote Console Mode, press Enter. The Remote Console Mode menu appears. Use 
the Up and Down arrow keys to select the desired mode. When Admin Mode has been selected, 
press Enter when done and perform the steps indicated to exit the ROM-based Setup Utility. 

The workstation blade performs a reboot, and then the Remote Console Mode appears. 
 

User mode 
When Remote Console Mode is set to User Mode, the boot console is generated by the ATI video 
controller. As booting of the Windows® operating system begins, the NVIDIA graphics adapter generates 
the Windows® desktop. 

In User Mode, the Windows® desktop can only be viewed using RGS through both NIC1 and NIC2 or 
either NIC1 and NIC2. Because the ATI video controller is inactive after the operating system starts, the 
Windows® desktop is not visible on the Local I/O Connector or through iLO 2. The screen displays a 
message stating that the blade is in User Mode. 

The default setting of Remote Console Mode is User Mode. This setting enables custom images (loaded 
through processes such as PXE booting) to boot directly into User Mode without needing to change 
Remote Console Mode from its default setting. 

In addition to viewing the Windows® desktop generated by one of the video controllers, you can also 
view the Windows® desktop using Microsoft® Remote Desktop Connection (RDC). For more information 
about RDC, see "Remote Desktop Connection (on page 51)." 

These viewing methods cannot be used simultaneously. If RDC is started, the Windows® desktop session 
provided by the video controller is terminated and returns to a Windows® login screen. If the user logs 
into the operating system while RDC is active, the RDC connection is terminated. 

 

Admin mode 
When Remote Console Mode is set to Admin Mode, the ATI video controller first generates the boot 
console during POST, and then generates the Windows® desktop. In this mode, the NVIDIA graphics 
adapter is not visible to any Windows® operating systems, and is not used. 

In Admin Mode, the boot console and the Windows® desktop generated by the ATI video controller can 
be viewed in the following ways: 

• Using a monitor connected to the Local I/O Connector video signal 

• Using the iLO 2 Remote Console by pointing your browser to the iLO 2 IP address 

• Using RDC 
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Server mode 
When Remote Console Mode is set to Server Mode, the ATI video controller generates the boot console 
during POST and then generates the Windows® desktop. In this mode, the NVIDIA graphics adapter is 
not visible to any Windows® operating systems and is not used. 

In Server Mode, the boot console and the Windows® desktop generated by the ATI video controller can 
be viewed in the following ways: 

• Using a monitor connected to the Local I/O Connector video signal 

• Using the iLO 2 Remote Console by pointing your browser to the iLO 2 IP address 

• Using RDC 
 

Setup mode 
Setup Mode is very similar to Admin Mode, the ATI video controller first generates the boot console and 
then generates the Windows® desktop. In Setup Mode, however, the NVIDIA graphics adapter, although 
it is not used, is visible to a Windows® operating system. 

Visibility of the NVIDIA graphics adapter enables the Windows® operating system to install the NVIDIA 
graphics adapter driver the first time the workstation blade boots. For more information about the initial 
workstation blade boot, see "Operating the workstation blade (on page 10)." 

In Setup Mode, the Windows® desktop can be viewed in the following ways: 

• Using a monitor connected to the Local I/O Connector video signal 

• Using the iLO 2 Remote Console by pointing your browser to the iLO 2 IP address 

• Using RDC 
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Operating the workstation blade 

WS460c installation process overview 
This chapter describes the following process to install, power on, boot and validate the HP Workstation 
Blade Solution: 

1. Set up the client computer. 

2. Install and power on the first workstation blade by performing these steps: 

a. Prepare the blade enclosure and the networking infrastructure. 

b. Configure the workstation blade hardware. 

c. Install the workstation blade into the enclosure and then boot the operating system. 

3. Configure the operating system. 

4. Verify network connections to the workstation blade Ethernet ports: NIC1, NIC2, and iLO 2. 

5. Install RGS on the workstation blade, and then verify RGS operation between the workstation blade 
and the client computer. 

6. Install the required applications on the workstation blade. 

7. Validate the solution consisting of the workstation blade, the applications, RGS, and the client 
computer. 

You can integrate other workstation blades and client computers into the solution. 
 

Installing and powering on the workstation blade 
For an overview see the HP ProLiant WS460c Workstation Blade with WS460c Graphics Expansion 
Blade Installation Instructions. Because the workstation blade shares many components with the server 
blade, see the following server blade documents for details on the installing and turning on the 
workstation blade: 

• HP BladeSystem c7000 Enclosure Setup and Installation Guide 

• Power Supply Installation Instructions for HP BladeSystem c7000 Enclosures 

• HP BladeSystem c3000 Enclosure Setup and Installation Guide 

• HP BladeSystem c3000 Tower Enclosure Setup and Installation Guide 

• HP ProLiant BL460c Server Blade User Guide 

• HP BladeSystem Onboard Administrator User Guide 

• Integrated Lights-Out 2 User Guide 

In addition, see your network interconnect device documentation. 
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Preparing the workstation blade infrastructure 
To prepare the workstation blade infrastructure (enclosure, power supplies, Onboard Administrator 
modules, and networking), perform the following steps: 

1. To set up the enclosure, including wiring the PDUs, follow the instructions in the HP BladeSystem 
c7000 Enclosure Setup and Installation Guide. 

2. Install power supplies in the enclosure according to the HP BladeSystem power guidelines on the HP 
website at http://www.hp.com/go/bladesystem/powercalculator 
(http://www.hp.com/go/bladesystem/powercalculator). 

3. Install the Onboard Administrator modules. If you are using multiple c3000 or c7000 Enclosures, 
connect the Onboard Administrator module in each enclosure to the uplink/downlink Ethernet 
connectors in each module. 

4. Install your network devices in the enclosure, and then connect them to your site network 
infrastructure. Hardware and Software Supported by HP ProLiant Workstation Blades describes the 
c7000 Enclosure interconnect bay mappings for the WS460c Workstation Blade.  

5. Connect power to the enclosure and power it up. When the enclosure is powered up for the first 
time, Insight Display launches an installation wizard. Complete the configuration process, and then 
verify no installation or configuration errors appear on the Insight Display. 

6. Verify the Onboard Administrator module and network devices can be accessed over the network 
from the PC. 

 

Configuring the workstation blade hardware 
The workstation blade hardware is configured before installing the blade in the enclosure. Unless 
otherwise noted, the hardware listed can be configured on the WS460c Workstation Blade. 

• Intel® Xeon® processors—The workstation blade supports Intel® Xeon® processors, offering multiple 
frequencies of each processor type. In dual processor configurations, both processors must be 
identical. For a description of the processors that are available for each workstation blade, see 
Hardware and Software Supported by HP ProLiant Workstation Blades. 

• Memory—Up to 12 memory DIMMs can be installed in the workstation blade, supporting up to 192 
GB of memory for the WS460c Workstation Blade. For a description of per-OS memory limitations, 
see Hardware and Software Supported by HP ProLiant Workstation Blades. 

• HP Graphic Expansion Blade—The graphics expansion blade comes attached to the top of the 
workstation blade and accommodates full length PCI-Express graphics cards. 

The graphics expansion blade can only be purchased factory-attached to the workstation blade. 

• NVIDIA Quadro FX graphics adapter—The WS460c Workstation Blade supports a number of 
graphics adapters, which can be ordered factory-installed or as after market option kits. For a list of 
the NVIDIA graphics adapters that are available, see Hardware and Software Supported by HP 
ProLiant Workstation Blades. 

• Disk drives—The WS460c Workstation Blade supports one or two SAS or SATA disk drives.  

• BBWC—The WS460c Workstation Blade can be ordered with either of these BBWC: 

o BBWC with 256 MB of memory. 

o BBWC with 512 MB of memory. 

For the latest information about BBWC, see the HP website. 
 

http://www.hp.com/go/bladesystem/powercalculator�
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Connecting media to the workstation blade 
The workstation blade architecture supports three primary methods of connecting media to the blade (such 
as a CD/DVD drive).  

• Connecting media to one of the USB connectors on the Local I/O Cable 

• Connecting a shared network drive to the blade 

• Using iLO 2 virtual media to mount PC media (such as a CD/DVD drive) to the workstation blade 

In addition, the c3000 Enclosure supports an optional DVD drive that can be used to install the operating 
system or software on a workstation blade. Using the c3000 Onboard Administrator, the DVD drive can 
be attached to any or all workstation blades in the enclosure. 

 

Powering on the workstation blade 
You can power on the workstation blade by using the Local I/O Cable, iLO 2 Remote Console, or 
Onboard Administrator. If you use the Local I/O Cable, then blade verification is not dependent on iLO 2 
networking (which, by default, requires a DHCP server to assign the IP address). If you use the Local I/O 
Cable, you can confirm that the iLO 2 IP address is set and you have the option of using the iLO 2 
Remote Console. 

HP recommends using the Local I/O Cable to power on the first workstation blade. When it has been 
verified (including DHCP assignment of the NIC1, NIC2, and iLO 2 IP addresses), subsequent workstation 
blades can be powered on using the iLO 2 Remote Console. This is consistent with a building block 
approach. 

To power on the workstation blade using the Local I/O Cable: 

1. Install the workstation blade in the c3000 or c7000 Enclosure. Because the blade is hot-pluggable, it 
can be inserted and removed while the enclosure is powered. 

2. Connect the Local I/O Cable to the Local I/O Connector on the front of the workstation blade. 
Connect a monitor, USB keyboard, and USB mouse to the Local I/O Cable. 

Depending on how you interact with the workstation blade and how many USB devices you have 
connected to the Local I/O Cable (such as a keyboard and mouse), you might have to add a USB 
hub to connect additional USB devices, such as a USB CD/DVD drive. 

3. Power on the blade by pressing the front panel Power On button. The boot sequence appears on the 
monitor. Set Remote Console Mode to Setup Mode, save the BIOS setting, and then continue with 
the boot process. 

4. If using the Graphics Expansion Blade, allow the Onboard Administrator to power up the blade. 
 

Workstation blade sleep states 
The workstation blade supports two sleep states: S0 (fully on) and S5 (off but connected to power). Do not 
use any other power management states (such as Hibernate or Standby). From sleep state S5, WOL is 
supported by both NIC1 and NIC2. However, a workstation blade in sleep state S5 is unable to respond 
to an RGS connection request from a client computer, which results in an RGS connection failure 
appearing on the client computer. When WOL occurs, the workstation blade boots into your operating 
system, an RGS connection can be established by the client computer. 
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OOBE screens 
When the workstation blade boots the operating system for the first time, it cycles through a number of 
OOBE screens. These screens enable you to configure several Windows parameters, including: 

• Region, keyboard layout, and input language 

• Time zone 

• End User License Agreement 

• Automatic Updates (enable or disable) 

• Computer name 

• Administrator password 

During the OOBE configuration process, the Administrator password screen appears. You must set an 
Administrator password. Without an Administrator password, RGS cannot authenticate, and no client 
connection is possible through an administrator account. 

After completing the OOBE process, the workstation blade reboots into your operating system. 
 

Configuring and verifying networking 
You must verify that the workstation blade is accessible over the network using NIC1, NIC2, and iLO 2. 
By default, the NIC1, NIC2, and iLO 2 IP addresses are set by DHCP. Therefore, ensure that the 
workstation blade can connect to a DHCP server. 

 

Configuring NIC 1 and NIC 2 
The following steps are based on continued use of a keyboard, mouse, and monitor connected to the 
Local I/O Cable. 

To verify NIC1 and NIC2: 

1. Choose one of the following options: 

o From a Windows® operating system, use the ipconfig command to verify that the NIC1 and 
NIC2 IP addresses have been set by DHCP.  

o Specify a static IP address and Subnet mask for each NIC. 

2. To verify NIC1 and NIC2 operation, access the blade SMH from your PC. Point a browser window 
at each IP address using HTTPS protocol and port 2381. The SMH page appears using each NIC. 

 

Verifying iLO 2 network 
1. Obtain the iLO 2 IP address by choosing one of the following methods: 

o Reboot the blade. During the reboot, the boot console displays the iLO 2 IP address. 

o Log in to SMH, and click Embedded NEC98431 under Management Processor, which displays 
the iLO 2 IP address. 

o Use Onboard Administrator. 

2. Point your PC browser window to the iLO 2 IP address (using HTTPS). The login screen appears. 
 



 

Operating the workstation blade 14 

Installing, configuring, and verifying RGS 
RGS (specifically, the RGS Sender) is not factory-installed on the workstation blade. You must obtain RGS 
from HP, and then have it installed on your workstation blade. A License Agreement Certificate is shipped 
with your workstation blade that enables you to download RGS at no cost from HP. See the certificate for 
downloading instructions. 

You can also purchase and install RGS 5.3.0 or later. To purchase RGS 5.3.0, go to the RGS homepage 
at http://www.hp.com/go/rgs (http://www.hp.com/go/rgs). RGS 5.3.0 and later require installation of 
a license to operate-for licensing details, see the HP RGS Licensing Guide, available on the RGS 
homepage. 

Download RGS to your PC (not directly to the workstation blade). The RGS Sender installation software 
can be made accessible by the workstation blade in several ways, including: 

• Map the workstation blade C: drive to your PC, and then copy the RGS files to the workstation blade 
drive. 

• Copy the RGS software to a CD, and then use iLO 2 virtual media from your PC to make the CD 
accessible by the workstation blade. 

Included with the RGS download is the HP Remote Graphics User Guide. Microsoft® Remote Desktop 
Connection can be used to remotely install the RGS Sender. 

RGS supports remote USB, which enables USB devices connected to the client computer to be attached to 
the workstation blade. This enables the workstation blade to access the USB devices as if they are 
connected directly to the workstation blade. During RGS installation, you are queried whether you want to 
enable remote USB. If you decide later to change remote USB (for example, to enable it from a disabled 
state), you must uninstall and reinstall the RGS Sender. 

 

Setting the RGS NIC binding order 
Because the workstation blade (the RGS Sender) has two network ports (NIC1 and NIC2), you must be 
careful when establishing a connection from the client computer (the RGS Receiver). The RGS Sender 
might listen on one NIC while the RGS Receiver is trying to establish a connection on the other NIC. The 
RGS Sender binds to the first NIC detected during booting. To determine the IP address of the first NIC, 
perform the following steps on the workstation blade: 

1. To view both NICs, click Start>Control Panel>Network Connections. 

2. Double-click each LAN icon and the Support tab, which displays the NIC IP addresses, but not which 
NIC is considered the first one. 

3. To determine which NIC is the first one, click Advanced>Advanced Setting in the Network 
Connections window. The Advanced Settings window appears. The first NIC is listed at the top in 
the Connections box.The first NIC is Local Area Connection 3, which has an IP address of 
10.10.42.59. This is the NIC that the workstation blade listens to an RGS connection. 

The arrows to the right of the Connections box can be used to change the order of the NICs to 
specify which NIC will be used by the RGS Sender. 

 

Before verifying RGS operation, set Remote Console Mode to User Mode by rebooting the workstation 
blade and selecting User Mode. The RGS Sender can operate only with the NVIDIA graphics adapter 
(which is active in User Mode). 

 

http://www.hp.com/go/rgs�
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Verifying RGS operation 
RGS connections are initiated from the client computer-see the RGS User Guide available at 
http://www.hp.com/support/rgs_manuals (http://www.hp.com/support/ws460c_manuals) for 
information on how to establish an RGS connection. While RGS supports several operating modes, HP 
recommends that you first attempt to establish a connection in Normal Mode, which is the simplest 
operating mode. 

RGS operation (as characterized by interactivity, security, and reliability) is dependent on your network 
design. 

 

Installing applications 
The workstation blade does not contain any removable-media storage devices (such as a CD/DVD drive 
or diskette drive). Therefore, you must first make the application installation package accessible by the 
workstation blade when installing applications. The four most common methods to make the package 
accessible are: 

• Blade hard drive—Copy the application installation package over the network to the workstation 
blade hard drive, and run the installation from the hard drive. 

• PC hard drive—Copy the application installation package to the hard drive of your PC. Log into the 
workstation blade from your PC using RGS, and then map the PC hard drive to the blade. Using 
RGS, run the installation package on the blade using the mapped network drive from the PC. A 
variation of this method is to save the installation package on a shared network drive, map the 
shared drive to the blade, and then install the application from the network drive. 

• Local I/O Cable CD/DVD drive—Connect a USB CD/DVD drive to the Local I/O Cable, and install 
the application from a CD or DVD. 

• iLO 2 virtual media—From your PC, use iLO 2 to connect to the workstation blade. Use the iLO 2 
Remote Console and Virtual Media capabilities to connect the required media device from the PC to 
the workstation blade. 

When the application installation package is accessible by the workstation blade, the installation can be 
initiated from your PC from the following devices: 

• RGS (requires User Mode) 

• iLO 2 Remote Console (requires Admin Mode, Setup Mode, or Server Mode) 

• Windows® Remote Desktop Connection 

• A keyboard, mouse, and monitor connected to the Local I/O Cable 

Each installation method has advantages and limitations: 

• Local installation using USB devices connected to the Local I/O Cable-This is generally the most 
reliable method, particularly for installations requiring multiple media. However, this method requires 
that you be physically present at the blade. A variation of this approach is to only attach the media 
using the Local I/O Cable, and then interact with the workstation blade remotely using RGS, RDC, 
or the iLO 2 Remote Console. However, manipulating media locally at the workstation blade while 
interacting remotely can be cumbersome. 

• Copying the installation package to a hard drive (either on the workstation blade or the PC)-This 
method might not be possible, depending on the application installation procedure used. In 
particular, installations requiring multiple CDs or diskettes may not work with this method. 

http://www.hp.com/support/ws460c_manuals�
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• Applications that depend on detection of the NVIDIA graphics adapter-The iLO 2 Remote Console 
and Local I/O Cable environments both require that the ATI video controller is displaying the 
Windows® desktop. If application installation depends on detection of the NVIDIA graphics 
adapter, an incorrect installation might result. 

• Using RDC—If application installation depends on detection of the NVIDIA graphics adapter, an 
incorrect installation might result. 

• Application installations that require a midway reboot-Both the Windows® RDC and RGS 
environments terminate their connections when the blade reboots. If application installation requires 
a midway reboot, RDC or RGS reconnection is required after the reboot. 

After selecting the application installation method, install the applications using the installation process 
specified by each application. 

 

Verifying functionality 
1. Launch the workstation blade applications from the client computer.  

2. Verify the applications work correctly, and provide the functionality, performance, and interactivity. 
 

Integrating additional workstation blades and client 
computers 

To ensure that each added device operates correctly with the existing solution components, HP 
recommends that you perform verification after each workstation blade and client computer is installed. 
For example, after integrating a new workstation blade into the solution, you can verify that RGS operates 
between the new workstation blade and an existing client computer. 
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Creating a custom Windows image 

Creating a custom Windows image for the WS460c 
Workstation Blade 

This chapter describes how to create a custom Windows® image for the WS460c Workstation Blade. 
You must include factory-installed components in your custom Windows® image. 

 

Creating a custom Windows® image process 
There are several ways to create a custom Windows image. This section describes creating the image by 
using the Windows® CD and adding the required software such as device drivers. All interactions are 
accomplished using a keyboard, mouse, CD/DVD drive, and monitor connected to the Local I/O Cable. 

 

Required components 
To create a custom Windows image, the following software and hardware components are required: 

• A way of connecting a diskette drive and a CD/DVD drive to the blade. This connection can be 
made in any of the following manners: 

o Local I/O Cable—Connect a USB hub, USB keyboard, USB mouse, USB CD/DVD drive, USB 
diskette drive, and a monitor to the Local I/O Cable. A USB hub is required, because the Local 
I/O Cable only has two USB connectors while four are required. 

o PC—From a PC, use iLO 2 Remote Console and virtual media to connect a diskette drive and 
CD/DVD drive to the blade. 

• Microsoft® Windows® installation CD with integrated Service Pack 2—The Microsoft® Volume 
License media or a retail version can be used. There is no activation required with Volume License 
media. Unlike other HP workstation products, operating system installation cannot be performed 
using the Windows® XP SP2 operating system CD included in the Restore Plus! CD set. 

• HP Remote Graphics Software—This CD is required for installation of the RGS Sender on the 
workstation blade. 

• Diskette containing the HP Smart Array P410i SAS controller drivers—Store the following files in the 
root directory of a diskette. These files are for Windows® XP 32-bit only: 

o hpcissm2.cat 

o hpcissm2.sys 

o hpcissx2.inf 

o txtsetup.oem (created by the software component for Windows® XP 32-bit) 

o hpciss2.pdb 
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To extract these folders from the HP Package Setup window, select Extract. You are prompted to 
specify the folder in which you want the files to be extracted. 

 
• CD containing the following required drivers-Download and store the following SoftPaqs on a CD: 

o ATI ES1000 graphics driver 

o NVIDIA FX graphics driver 

o HP NC-Series Broadcom 10GbE Multifunction driver 

o HP ProLiant Integrated Lights-Out 2 Management Interface driver 

o HP ProLiant iLO 2 Advanced and Enhanced System Management Controller health driver 
 

Optional software 
The following software components are optional, and can be downloaded from the workstation blade 
software and drivers website: 

• CD containing SMH—SMH enables the status of the blade to be remotely monitored. 

• CD containing HP Insight Management Agents—The Management Agents are required if SMH is 
installed, or if HP SIM is used to remotely manage the blade. 

 

Creating the Windows® XP image 
1. Connect a monitor, USB hub, keyboard, mouse, diskette drive, and CD/DVD drive to the Local I/O 

Cable. 

2. Cycle power on the blade to initiate a reboot. When the BIOS console appears, change the BIOS 
Remote Console Mode to Setup Mode. Setup Mode causes the NVIDIA graphics adapter and ATI 
video adapter to both be visible to the Windows® operating system to ensure correct driver 
installation. 

3. Boot to the ISO image with both the floppy and diskette driver (HPcissm2) mounted using the virtual 
media. 

4. Boot the workstation blade from the Windows® XP CD. 

5. Immediately after booting the Windows® operating system from the CD, press the F6 key when 
prompted. This step is required to install third-party drivers. The HP Smart Array P410i SAS controller 
driver is installed. 

6. When prompted, press the S key to indicate the availability of a diskette with the P410i SAS 
controller driver. Press Enter. 
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7. When prompted for the driver diskette, insert the diskette containing the HP Smart Array P410i SAS 
controller drivers, and then press Enter. 

8. Select the Windows® 2000 Driver for Smart Array P410i SAS controller driver. Press Enter to install 
the driver. 

9. When prompted, press Enter to begin the Windows® XP installation. 

10. When prompted, select the manual installation option. 

11. When prompted, press F8 to accept the Microsoft® End-User Agreement. 

12. Partition the hard drive. If your drive is bigger than 80Gb, verify that the partition to which you are 
installing the OS is 80Gb or less. 

13. Install Windows® XP Pro in this newly-created partition. 

14. Enter C to proceed with manual installation. 

15. If the Windows® setup GUI prompts you for unsigned drivers, click Yes to install drivers that have 
not passed Windows® Logo testing. 

16. Customize Windows® XP Pro by answering the Microsoft® OOBE questions, such as the time zone 
and computer name. 

17. Enter the 25-character product key that identifies your copy of Windows® XP Professional. 

18. Set the regional and language options. 

19. From the Computer Name and Administrator Password screen, enter an Administrator password 
(required for the workstation blade). Both RGS and Windows® Remote Desktop Connection require 
access to a password-protected account. The password enables most of the remaining system 
configuration and application installation tasks to be performed over the network using RGS or 
Remote Desktop Connection. 

20. Install the following drivers: 

o ATI ES1000 graphics driver for the ATI video controller 

o Broadcom NetXtreme Gigabit LAN driver for the NC532i 

o NVIDIA Quadro FX graphics adapter driver 

o HP ProLiant Integrated Lights-Out 2 Management Interface driver 

o HP ProLiant iLO 2 Advanced and Enhanced System Management Controller health driver 

21. (Optional) HP recommends installing the following QFEs: 

o Windows® 2007 Time Zone Update (Q928388) 

o HTML Help Vulnerability (Q896358) 

o DhcpRequestParams function broken on SP2 (Q885270) 

o DEP enabled Windows® SP2 system fail resume (Q889673) 

o Vulnerabilities in Windows® XP-32 kernel (Q890859) 

22. If you are installing the management agents (recommended), two additional components are 
required, which must be installed in the following order: 

a. SNMP—This component is installed as follows: 

i. Open the Windows Components Wizard. Select Management and Monitoring Tools, and then 
click Details. Select Simple Network Management Protocol, and then click OK. 

ii. Verify that SNMP Service in the Windows Component Services box displays Started. Right 
click SNMP Service, select Properties, and then click the Security tab. Ensure that the 
properties appear. If not, modify the Accepted community names. Other community names 
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can be used. To modify the Integrated Management Log with the management agents, you 
must have a READ WRITE community defined. 

b. HP Insight Management Agents—You must also have this component to use SMH or HP SIM. 
 

Configuring the operating system 
After the Windows® operating system starts, configure it as follows: 

1. Configure a solid-color Windows® wallpaper to maximize RGS performance.  

2. If needed, configure WOL. 

3. Turn off all power management functions (for example, hibernation) so that the workstation blade is 
powered on and available to respond to requests. 

4. Configure the Start > Shut Down menu to have two options, Restart and Log off. Remove the Shut 
down, Stand by, and Hibernate options, because they require administrator intervention to power up 
the blade. 

5. Configure the Windows® Firewall—The Windows® XP Professional SP2 Internet Connection 
Firewall has default settings that are too restrictive for many of the remote access and management 
functions. HP recommends the following firewall exceptions: 

o Windows® Remote Desktop Connection—Remote Desktop program exception 

o Windows® Remote Assistance—Remote Assistance program exception 

o Windows® File and Print Sharing (required for Rapid Deployment Pack)—File and Printer 
Sharing program exception 

o HP Remote Graphics Software—Add C:\Program Files\Hewlett-Packard 

o Remote Graphics Sender—\rgsender.exe program exception 

o SMH—Add the port exceptions listed in the table. 
 

Description Port Protocol 

HP SMH Web Server 2301 HTTP 

HP SMH Secure Web Server 2381 HTTPS 

WBEM/WMI Mapper 5988 HTP 

WBEM/WMI Mapper (Secure) 5989 HTTPS 

SSH Port 22 SSH 

SNMP Agent 161 SNMP 

SNMP Agent 162 SNMP Trap 

Ping Discovery (ICMP) — ICMP 

Ping Discovery (TCP) 80 HTTP 

Management Processor 443 HTTPS 
 

When configuring ports for HP SMH and HP SIM, see the HP Customer Advisory HP Systems Insight 
Manager and HP System Management Homepage Do Not Function Properly After Upgrade to Microsoft 
Windows XP SP2. This advisory can be found by searching on the Customer Advisory number, 
"c01202170", in the search box at http://www.hp.com (http://www.hp.com). 
 

Description Port Protocol 

RGS Sender 42966 SSL 
 

http://www.hp.com/�
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If HP Rapid Deployment Pack is used, enable the File and Print Sharing program exception. Also add the 
port exceptions listed in the following table to enable HP Rapid Deployment Pack access to the 
workstation blade. 
 

Port Type Description 

53 TCP RDP DNS and SQL 

53  UDP RDP DNS 

67 TCP RDP DHCP REQ 

68 TCP TDP DHCP REP 

69 TCP RDP M-TFTP 

80 TCP RDP iLO and HTTP 

88 TCP RDP Kerberos 

88 UDP RDP Kerberos 

123 UDP RDP SNMP 

135 TCP RDP AeXNS, DCOM and SQL 

135 UDP RDP AeXNS and DCOM 

137 TCP RDP Netlogon SMB and SQL 

161 TCP RDP SNMP 

162 TCP RDP SNMP 

389 UDP RDP LDAP ping 

401 TCP RDP WOL 

402 TCP RDP Dep Agents 

445 UDP RDP MS-DS 

636 TCP RDP SSL LDAP 

750 TCP RDP Windows® 2000 AD 

751 TCP RDP Windows® 2000 AD 

752 TCP RDP Windows® 2000 AD 

753 TCP RDP Windows® 2000 AD 

754 TCP RDP Windows® 2000 AD 

1010 TCP RDP PXEConfig 

1433 TCP RDP SQL 

1500 TCP RDP RPC 

1758 TCP RDP TFTP 

1759 TCP RDP TFTP 

2381 TCP RDP, RDP Web Agent 

2500 TCP RDP RPC 

4011 TCP RDP Ext DHCP PXE 
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For more information about creating the Windows® XP image, see "Creating the Windows® XP image 
(on page 18)". 

 

Installing the applications 
HP recommends that you install the following applications before installing user applications: 

• Microsoft® .NET Framework—This software is required by many Windows® applications. 

• Sun Java™ Virtual Machine (JVM) for Internet Explorer—This software is required to use iLO 2 
Remote Console capabilities that depend on a JVM—enabled browser. 

• Adobe® Acrobat® Reader—This software is required to view .pdf files. 

• Altiris Aclient—This software is required to use HP Rapid Deployment Pack to image the workstation 
blade. 

 

Deploying the Windows image 
1. Run sysprep to generate new security IDs on each target system. 

2. Capture the image. 

3. Deploy the image to the workstation blades. 
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Using Windows® XP-64 on the workstation 
blade 

Windows® XP-64 on the workstation blade 
While Windows® XP-64 is supported on the workstation blade, this OS is not available factory-installed. 
Windows® XP-64 needs to be acquired, installed, and configured by your IT department. Because so 
many of the Windows® XP-64 processes are similar to the processes for Windows® XP-32, this chapter 
focuses on those processes that are different or unique for Windows® XP-64. 

 

Windows® XP-64 processes 
This section assumes you are familiar with the chapter "Creating a custom Windows® XP image." This 
section describes the key differences in how Windows® XP-64 is deployed compared to Windows® XP. 
The key aspects are: 

• Acquire the Windows® XP-64 installation media from Microsoft®. 

• For a list of hardware and software that is supported on Windows® XP-64, see the document 
Hardware and Software Supported by HP ProLiant Workstation Blades, available at 
www.hp.com/support/WS460c_manuals (http://www.hp.com/support/ws460c_manuals). 

• The Windows® XP-64 software and drivers need to be downloaded from HP. When prompted to 
select the operating system, select Microsoft® Windows® XP Professional x64 Edition. To extract the 
files to create the diskette you will use during the XP-64 installation from the HP Package Setup 
window, click Extract. 

 

To install the Windows® XP image, see "Creating the Windows® XP image (on page 18)". 

In some cases, the identical SoftPaqs are available on both the 32-bit and 64-bit download pages. For 
example, for the Broadcom Multifunction Drivers, the 32-bit and 64-bit SoftPaqs are identical. In other 
instances, such as the SATA/SAS Controller Driver, there are unique 32-bit and 64-bit SoftPaqs. This 
information might enable some efficiencies in your management of SoftPaqs if you are supporting 
workstation blades running both Windows® XP-32 and Windows® XP-64. 

http://www.hp.com/support/ws460c_manuals�
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• Version 2.2 of the HP SAM SoftPaq is required for Windows® XP-64. The previous SAM release, 
version 2.1, is not supported on Windows® XP-64. 

• The BIOS version is not dependent on the operating system that you are using. A common BIOS 
supports all three operating systems: Windows® XP-64 and Red Hat Enterprise Linux 4. HP 
recommends updating your workstation blades to the latest BIOS version available. 

• QFEs are OS-specific. Install the Windows® XP-64 QFEs required by your IT department. 64-bit 
QFEs are available on the HP download web page referenced above. Also, search 
http://www.microsoft.com (http://www.microsoft.com) for 64-bit QFEs. 

http://www.microsoft.com/�
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Using Windows Vista® on the workstation blade 

Acquiring Windows Vista® 
Windows Vista® recovery media is shipped with your workstation blade. If your Windows Vista® 
recovery media is lost or damaged, you can order new recovery media. 

The Windows Vista® recovery media does not contain the following four modules. You must download 
and install these modules after Windows Vista® is installed: 

• HP Insight Management Agents 

• HP ProLiant iLO 2 Management Controller Driver 

• HP ProLiant Integrated Lights-Out Management Interface Driver 

• HP System Management Homepage 
 

Installing Windows Vista® 
This section describes how to install Windows Vista® using the Windows Vista® OS DVD and the 
RestorePlus! DVD. 

The installation process repartitions and reformats the workstation blade hard drive. Because all files are 
deleted from the hard drive during this process, be sure to archive all important files before beginning the 
installation. 

There are two primary methods to install Windows Vista®: 

• Run the installation process using devices attached to the Local I/O Cable-A USB hub (with a 
keyboard, mouse, and CD/DVD drive), and a monitor. 

• Run the installation process using iLO 2 virtual media from your local PC. Note that this method is 
slower than the above method, and is susceptible to network issues. 

In the description of the installation process in the next section, CD/DVD drive refers to either to a USB 
CD/DVD drive connected to the Local I/O Cable or to a CD/DVD drive on your client PC connected to 
the workstation blade through iLO 2 virtual media. 

 

Windows Vista® installation steps 
Perform the following steps to install Windows Vista® on the workstation blade: 

1. Insert the Windows Vista® RestorePlus! DVD into the CD/DVD drive. 

2. Boot the workstation blade from the DVD. When the GUI Language selection screen appears, select 
a language (for the installation process, not for localization of the operating system), and then click 
Next. 

3. After selecting the GUI Language for the install process, a warning message appears, advising you 
that all data will be erased from your primary hard disk drive. Click Begin. 

4. Select the operating system language, and then click Next. A warning message appears. 
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5. Click Next. 

6. Choose a partitioning scheme. The default partitioning scheme uses the entire disk drive for the C: 
partition. To select a different partitioning scheme, use the blue arrows to make your selection, and 
then click Next. 

7. After requesting confirmation of the hard drive erasure two more times, the restore process partitions 
and formats the hard drive. Files are then copied from the RestorePlus! DVD to the hard drive. 

8. You are prompted to insert the operating system DVD. Insert the Windows Vista® DVD, and click 
Next. 

9. Files are copied from the Windows Vista® DVD to the hard drive. When prompted, remove the 
DVD.  

10. When prompted for an optional Supplemental CD, click Skip to proceed without one. The 
application CDs are not Supplemental CDs. 

11. When prompted for a Special Content CD, click Skip if you do not have a Special Content CD. 

12. When a message appears advising you that the CD-specific portion of the process is complete, click 
Begin Setup. The remainder of the installation process runs entirely from the hard drive. 

13. The restore process automatically begins installing software. When the Microsoft® OOBE screens 
appear, answer the questions specific to your installation. 

14. After entering the OOBE information, click OK to reboot the workstation blade into Windows 
Vista®. 

 

Viewing the Windows Vista® desktop 
Because the RGS Sender is not currently supported on Windows Vista®, you can use the following 
methods to view the Windows Vista® desktop. The first two methods provide remote viewing of the 
Windows desktop, while the third method provides local viewing. 

• Operate the workstation blade with Remote Console Mode set to Admin Mode—In Admin Mode, the 
Windows desktop is generated by the ATI video controller, which can be viewed remotely using the 
iLO 2 Remote Console. 

• Microsoft® Remote Desktop Connection—Microsoft® Remote Desktop Connection can be used to 
remotely view the Windows Vista® desktop. 

• Use expansion blade graphics—This method assumes that your workstation blade has an HP 
Graphics Expansion Blade attached, and that you have an NVIDIA PCI Express graphics adapter 
installed in the expansion blade. In this case, you can view the Windows Vista® desktop by 
connecting a monitor to the DVI connector on the graphics adapter. Remote Console Mode should 
be set to User Mode to ensure the Windows desktop is generated by the NVIDIA graphics adapter. 
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Capturing a workstation blade image using HP 
Insight Rapid Deployment Software 

Using HP Insight Rapid Deployment Software 
HP Insight Rapid Deployment Software can be used to capture the OS image of the workstation blade for 
both Windows®, both 32- and 64-bit. This chapter assumes you are familiar with Rapid Deployment 
Software. For more information on HP Insight Rapid Deployment Software, see the HP website. 

The following flowchart provides an overview of the process used to capture the OS image. The first 
flowchart branch depends on whether you plan to use Altiris to run Sysprep, or if you plan to run Sysprep 
manually. 

Step 1: Configure the workstation blade (reference computer) from whose the image is captured. 

Prepare the workstation blade whose image is to be captured: 

a. Install, update, and configure the OS—Ensure that the OS is configured as desired, including 
updates and patches. 

b. Change Remote Console Mode—If you need to view the capture process using the iLO 2 Remote 
Console or the Local I/O Connector of the workstation blade, Remote Console Mode must be set 
to Admin Mode or Setup Mode. See "Setting Remote Console Mode (on page 8)," for 
information on setting Admin Mode or Setup Mode. 

Rapid Deployment Software contains jobs that can be used to automatically set Remote Console 
Mode to the desired state. 

Letting Remote Console Mode to Admin Mode or Setup Mode is not required for capturing an 
image. It enables you to view the capture process using iLO 2. If Remote Console Mode is in 
User Mode, you cannot view the Windows® desktop until after the image is captured, and you 
use RGS or Remote Desktop Connection to log into the workstation blade. 

If you do set Remote Console Mode to Admin Mode or Setup Mode, you must change the mode 
back to User Mode after the image is captured. 

To capture an OS image and deploy it to multiple other computers, the Sysprep tool must be run 
to set a new SID and to apply new system settings, such as the computer name. If you plan to use 
Altiris Deployment Server to run Sysprep, continue with Step 2. If you plan to run Sysprep 
manually, proceed to Step 5.  

Step 2: If required, configure the Altiris Deployment Server to run Sysprep. 

Depending on your Rapid Deployment Software configuration, this step may have already been 
completed. To configure the Altiris Deployment Server to run Sysprep, refer to the Deployment Solution 
documentation available from Altiris at http://www.altiris.com (http://www.altiris.com). 

Step 3: Configure the A-Client (Altiris Agent) so that it is installed on the workstation blade. 

If you are using Altiris to run Sysprep, you must configure the A-client (Altiris Agent) so that it is installed 
on the workstation blade by performing these steps: 

http://www.altiris.com/�
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a. On the Altiris Deployment Server, click Tools > Remote Agent Installer. The Remote Agent Installer 
screen appears. Select Use this username and password for client/s. Using an Administrative 
account local to target, Click Next. 

b. Accept the default install directory path or choose your own, and then select Enable this agent to 
use SIDgen and/or Microsoft Sysprep. 

c. To configure optional settings on the A-client, click the Change Settings button, and then click 
Next. 

d. Click the dropdown arrow, and then select Use only Microsoft Sysprep utility. Locate the 
DEPLOY.cab file you downloaded in Step 2, and in the XP/2003 box, using the browse button 
next to Windows® XP/2003, click Next. 

e. Select Add client(s) to default group, or select the group to add them to. 

f. On the Selecting Clients screen, select or add the Names or IP address of the workstation blades 
you want to install A-clients on by using the Add button. You can select multiple workstations at a 
time. When finished adding workstations, select Finish. The progress and results of the Altiris 
Agent installation appear. 

Step 4: Create a job that captures the image using Altiris to run Sysprep. 

Perform the following steps to create a new job that captures the OS image using Altiris to run Sysprep: 

a. Under the jobs pane in the white area, right-click and select New Job. Enter a unique name for 
the job. Double click the new job, click Add>>, and then select Create Disk Image. 

b. On the Save Disk Image to a file screen next to the name field, click the browse button, locate 
the images folder (<Express Share>\Images), and then enter a unique image name for your 
image. Click Save. 

c. Select Prepare using Sysprep, and then enter the Product key to be used. If you have a specific 
pre-boot environment you want to run the image in, select it at the bottom of the screen. The 
default is WinPE. 

d. Accept the defaults on the Return Codes screen. 

Continue to Step 7. 

Step 5:  Run Sysprep manually. 

To run Sysprep manually, see the article "How to use the Sysprep tool to automate successful deployment 
of Windows® XP," available at http://www.microsoft.com/kb/302577 
(http://www.microsoft.com/kb/302577). If you run Sysprep manually, you must run it, shut down the 
computer, and boot directly to PXE manually (F12 on POST) to run the image process without booting to 
the OS first. 

Step 6: Create an Altiris job to capture the image that does not use Altiris to run Sysprep. 

To create an Altiris capture job that does not run Sysprep, perform the following steps: 

a. Under the jobs pane in the white area, right-click and select New Job. Enter a unique name for 
the job. Double click the new job, click Add>>, and then select Create Disk Image. 

b. On the Save Disk Image to a file screen, next to the name field, click the browse button, locate 
the images folder (<Express Share>\Images), and then enter a unique image name for your 
image. Click Save. 

c. Click the Advanced button next to the pre-boot select. In the middle of the screen, select Do not 
boot to production. Altiris A-Client does not run the system image preparation procedure that 
includes Sysprep. Use this selection: 

http://www.microsoft.com/kb/302577�
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— If you are running Sysprep manually 

— If you are not using Sysprep at all and want to make a carbon image of you computer 

d. Accept the defaults on the Return Codes screen. 

Step 7: Apply the new Altiris job to computers whose images you are capturing. 

o You can drag and drop that job to computers in the HP RDP console.  

o Select the computer in the Computers pane of the Altiris Console. In the right pane, you can see 
all running jobs and their status.  
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Deploying a workstation blade image using HP 
Insight Rapid Deployment Software 

Using HP Insight Rapid Deployment Software for 
Windows® XP-64 

HP Insight Rapid Deployment Software can be used to deploy an operating system image to the 
workstation blade for both Windows® XP-32 and Windows® XP-64. This chapter assumes you are 
familiar with HP RDP. For detailed information on HP RDP, visit http://www.hp.com/go/rdp 
(http://www.hp.com/go/rdp). You must have an existing workstation blade image ready to deploy. 

The following procedure provides an overview of the process used to deploy an OS image. The first 
flowchart branch depends on whether you plan to use Altiris to run Sysprep, or if you plan to run Sysprep 
manually. Following the flowchart, the details of each step are presented. 

Step 1:  If needed, change Remote Console Mode. 

If you need to view the deployment process using the iLO 2 Remote Console or the Local I/O Connector 
of the workstation blade, Remote Console Mode must be set to Admin Mode or Setup Mode. for 
information on setting Admin Mode or Setup Mode, see "Setting Remote Console Mode (on page 8)."  

HP Rapid Deployment Software contains jobs that can be used to automatically set Remote Console Mode 
to the desired state. 

Setting Remote Console Mode to Admin Mode or Setup Mode is not required for deploying an image. It 
enables you to view the deployment process using iLO 2. If Remote Console Mode is kept in User Mode, 
you cannot view the Windows® desktop until after the image is deployed, and you use RGS or Remote 
Desktop Connection to log into the workstation blade. 

If you do set Remote Console Mode to Admin Mode or Setup Mode, you must change the mode back to 
User Mode after the image is deployed. 

Step 2:  If required, configure the Deployment Server to run Sysprep. 

Depending on your HP Rapid Deployment Software configuration, this step might need to be completed. 
To configure the Altiris Deployment Server to run Sysprep, see the Deployment Solution documentation 
available from Altiris at http://www.altiris.com (http://www.altiris.com). 

Step 3:  If needed, install A-Client (Altiris Agent) on the target computer (this agent will use Sysprep). 

If the target computer currently has an OS installed, you can optionally install the Altiris A-client to 
automate the system shutdown and PXE boot. If the target computer already has A-client installed, and is 
seen by the Altiris deployment console, you do not need to perform this step. To install the Altiris A-client, 
perform the following steps: 

a. Click Tools>Remote Agent Installer. The Remote Agent Installer screen appears. Select Use this 
username and password for client/s. Using an Administrative account local to target, click Next. 

b. Accept the default install directory path or choose your own. 

http://www.hp.com/go/rdp�
http://www.altiris.com/�
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c. Because you are using Altiris to run sysprep, select Enable this agent to use SIDgen and/or 
Microsoft® Sysprep. 

d. To configure option settings on the A-client, click the Change Settings button. Click Next. 

e. Click the arrow, and then select Use only Microsoft Sysprep utility. Locate the DEPLOY.cab file 
you downloaded in step 2, and in the XP/2003 box using the browse button next to Windows® 
XP/2003, click Next. 

f. Select Add client(s) to default group, or select the group you want them to be added to. 

g. On the Selecting Clients screen, select or add the Names or IP address of the workstations you 
want to install A-clients to. Use the Add button to select multiple at a time. When finished adding 
systems, select Finish. The progress and results of the installation appear. 

Step 4:  Create a new job (that uses Altiris to run Sysprep) to deploy the OS image. 

Perform the following steps to create a new job that deploys the OS using Altiris to run Sysprep: 

a. Under the jobs pane, right-click in the white area and then select New Job. Enter a unique name 
for the job. Double click the new job, click Add>>, and then select Distribute Disk Image. 

b. Use the browse button next to the name field to locate the image file you want to use. This file 
must be located on the Altiris express share or a location manually mapped for Altiris and pre-
boot environment to use. 

c. Select Prepared Using Sysprep. Add the appropriate operating system and Key. 

d. To specify the Sysprep answer file, select advanced. Select Use default answer file to use the 
Altiris default file (this can be modified), or Use the following answer file to enter your own. 

e. Select the appropriate boot environment, click Next, accept the defaults, and then click Finish. 

Continue with Step 7. 

Step 5:  If needed, install A-Client (Altiris Agent) on the target computer (this agent will not use Sysprep). 

If the target computer currently has an OS installed, you can optionally install the Altiris A-client to 
automate the system shutdown and PXE boot. If the target computer already has A-client installed, and is 
seen by the Altiris deployment console, you can omit this step. To install the Altiris A-client, perform the 
following steps: 

a. Click Tools>Remote Agent Installer. The Remote Agent Installer screen appears. Select Use this 
username and password for client/s. Using an Administrative account local to target, click Next. 

b. Accept the default install directory path, or choose your own. 

c. To configure option settings on the A-client, click the Change Settings button. Click Next. 

d. Select Add client(s) to default group, or select the group you want them to be added to. 

e. On the Selecting Clients screen, select or add the Names or IP address of the workstations you 
want to install A-client(s). Use the Add button to select multiple at a time. When finished adding 
systems, select Finish. The progress and results of the installation appear. 

STEP 6:  Create a new job (that does not use Altiris to run Sysprep) to deploy the image 

Perform the following steps to create a new job that deploys the OS, but does not use Altiris to run 
Sysprep: 

a. Under the jobs pane, right-click in the white area, and then select New Job. Enter a unique name 
for the job. Double click the new job, click Add>>, and then select Distribute Disk Image. 

b. On the first screen, use the browse button next to the name field to locate the image file you want 
to use. This file must be located on the Altiris express share or a location manually mapped for 
Altiris and pre-boot environment to use. 
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c. Select the appropriate boot environment, click Next, accept the defaults, and then click Finish. 

Step 7:  Deploy the OS using the new Altiris job. 

This step might require a manual PXE boot, depending on whether you have configured the Altiris A-client 
to automate computer shutdown and PXE boot. To perform a manual PXE boot, press F12 key during 
POST. 

a. Drag and drop that job to computers in the HP RDP console.  

b. By selecting the computer in the Computers pane of the Altiris Console in the right pane, you can 
view the job and the status.  
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Performing an unattended installation of 
Windows® XP 

Unattended installations 
This chapter provides an overview of the steps to perform an unattended installation of Windows® XP. 
This chapter describes the essential elements that are specific to workstation blades. 

 

Unattended installation procedure 
This section describes the steps to perform an unattended installation of Windows® XP and Windows® 
XP-64. 

1. Create and update the remote install distribution share. 

2. In the distribution share, create a directory structure to store the OS installation files as well as the 
HP-specific drivers and software for the workstation blade.  

a. Windows® XP Pro SP2—The $OEM$ folder is created under the i386 directory, which was 
originally created manually or via Remote Installation Service.    

b. Windows® XP Pro x64—The AMD64 and i386 subdirectories contain the OS files, and the 
$OEM$ folder needs to be on the same level as amd64 and i386 

3. Download the software and drivers required for unattended installation  

a. Uncompress the SoftPaq, and copy the folder and contents of the conrep and unsignok folders to 
the $OEM$\$1\HP_Install directory.  

b. Download the latest drivers and software for the workstation blade. 

c. Copy RGS and additional utilities in various distribution sub-folders. 

4. Create regedit command files in the $OEM$\$1\HP_Install directory to change registry settings 
for RGS to work properly. 

The following registry modifications are given as examples only. Editing the registry can cause 
serious issues with Windows®. Although these examples have been shown to work, use these 
examples at your own risk. 

a. Turn off Fast User Switching—In this example, Fast User Switching is turned off by a script file 
called "FastUserSwitching.reg", which contains the following lines: 
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows 
NT\CurrentVersion\Winlogon] 
  "AllowMultipleTSSessions"=dword:00000000 
  "LogonType"=dword:00000000 

Where: 

LogonType—Set to 0 to display the security dialog box, set to 1 to display the new Welcome 
screen.  
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AllowMultipleTSSessions—Set to 0 to disable fast user switching, set to 1 to allow 
switching.  

b. Turn off Simple File Sharing—In this example, Simple File Sharing is turned off by a script called 
"Simple File Sharing.reg" with the following lines: 

 [HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Lsa] 

"forceguest"=dword:00000000 

Where: 

forceguest-Set to 0 to disable and turn off simple file sharing, set to 1 to turn on simple file 
sharing.  

5. Add workstation blade-specific entries to the different sections of the unattended answer file, either 
unattend.txt or ristndrd.sif (for RIS installation). The following entries are based on the example 
directories created in step 2, and must be adapted to your configuration if it differs from the 
directories shown in step 2.  

See Microsoft® documentation for additional details on the creation of the unattended.txt file. 

a. Windows® XP Pro SP2 

— Add to the [Unattended] section 

Plug and Play driver location: 
OemPNPDriversPath=\textmode;HP_Install\Drivers\chipset\intel;HP_Ins
tall\Drivers\graphics\ati;HP_Install\Drivers\Management\IMA;HP_Inst
all\Drivers\Management\ILO_MC;HP_Install\Drivers\Management\ILO_MI;
HP_Install\Drivers\network\Broadcom 

Other settings:  
OemPreinstall=Yes 
DisableVirtualOemDevices=Yes 
DriverSigningPolicy=Yes 

— Add to the [MassStorageDrivers] section 
[MassStorageDrivers] 
"Windows 2000 Driver for Smart Array E200 and E200i 
Controllers"=OEM 

— Add to the [OEMBootFiles] section 
[OEMBootFiles] 
CISSm2.sys 
HpCISSx2.inf 
HpCISSm2.cat 

txtsetup.oem 

— Add to the [GuiUnattended] section 
[GuiUnattended] 
AutoLogonCount=2 

— Add to the [NetOptionalComponents] section  
[NetOptionalComponents] 
SNMP = 1 

The above entry installs SNMP during setup. This is required in order for the management 
agents to install. 



 

Performing an unattended installation of Windows® XP 35 

— Add to the [GuiRunOnce] section 
[GuiRunOnce] 
"%systemdrive%\HP_Install\Driver_Software_Install2.cmd" 

The above entry will run the install script "Driver_Software_Install.cmd" (see Appendices) that 
will install drivers and software at first login after install. 

— Add to the [WindowsFirewall] section 
[WindowsFirewall] 
Profiles = WindowsFirewall.TurnOffFirewall 
[WindowsFirewall.TurnOffFirewall] 
Mode = 0 

In the above firewall example, the Windows® firewall is disabled see the Windows® 
documentation on firewall settings). In practice, HP does not recommend disabling the 
Windows® firewall unless another firewall is in use. See "Configuring the operating system 
(on page 20)" for recommended firewall settings.  

b. Windows® XP Pro x64 

— Add to the [Unattended] section: 

Plug and Play driver location: 
OemPNPDriversPath="\\%SERVERNAME%\RemInst\%INSTALLPATH%\$OEM$\textm
ode;Drivers\HP_NULL_IPMI;Drivers\HP_SmartArray_E200i_SAS;Drivers\In
tel_chipset;Drivers\ " 

For both Windows® XP-32 and Windows® XP-64, the path for the NVIDIA driver is 
intentionally omitted. Because the workstation blade contains two video controllers, the 
workstation makes the NVIDIA driver primary during the install, and if Remote Console Mode 
is in Setup Mode, the screens go black. This change occurs because the iLO Remote Console 
and Local I/O Connector displays are controlled by the ATI controller, and are deactivated if 
NVIDIA is the primary controller. The NVIDIA driver is installed later in the installation 
process and activated before switching to User Mode. 

The ATI drivers that are downloadable from the workstation blade software and drivers web 
page are not Microsoft® signed. If you do not to use the unsigned drivers, the default VGA 
driver in the operating system is loaded. Remove the ATI lines in the driver path to prevent 
the ATI driver from loading. 

Other settings: 
OemPreinstall=Yes 
DisableVirtualOemDevices=Yes 
DriverSigningPolicy=Yes 

— Add to the [MassStorageDrivers] section: 
[MassStorageDrivers] 
"Windows Driver for Smart Array SAS/SATA Controllers"="OEM" 

— Add to the [OEMBootFiles] sections: 
[OEMBootFiles] 
txtsetup.oem 
hpcisss2.cat 
hpcisss2.sys 
hpcissx2.inf 
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— Add to the [GuiUnattended] section: 
[GuiUnattended] 
AutoLogonCount=2 

— Add to the [NetOptionalComponents] section: 
[NetOptionalComponents] 
SNMP = 1 

This entry installs SNMP during setup. This entry must be made must be made, or the 
management agents will not install correctly. 

— Add to the [GuiRunOnce] section: 
[GuiRunOnce] 
"%systemdrive%\HP_Install\Driver_Software_Install2.cmd" 

This entry runs the install script Driver_Software_Install.cmd, which will install drivers and 
software at first login after install. 

— Add to the [WindowsFirewall] section: 
[WindowsFirewall] 
Profiles = WindowsFirewall.TurnOffFirewall 
[WindowsFirewall.TurnOffFirewall] 
Mode = 0 

In this example, the Windows® firewall is disabled (see Windows® documentation on 
firewall settings). In practice, HP does not recommend disabling the Windows® firewall 
unless another firewall is in use. See "Configuring the operating system (on page 20)" for 
recommended firewall settings.  

— (Optional) [NetAdapters] sections—To ensure that the network card is enumerated correctly, 
specifically state them in the unattended file. For example: 
[NetAdapters]  
Adapter01=Params.Adapter01 
 Adapter02=Params.Adapter02 
[Params.Adapter01]  
 InfID="b06bdrv\l2nd&pci_164c14e4"  
PciBusNumber = 3 
 PciDeviceNumber = 0  
 PciFunctionNumber = 0  
 ConnectionName = "HP NC373i Multifunction Gigabit Server Adapter 
#1"  
[Params.Adapter02]  
 InfID="b06bdrv\l2nd&pci_164c14e4"   
 PciBusNumber = 7  
 PciDeviceNumber = 0  
 PciFunctionNumber = 0  
 ConnectionName = "HP NC373i Multifunction Gigabit Server Adapter 
#2" 

6. Using an RIS server—If you are using Microsoft® RIS, you must add network drivers to the i386 
(Windows® XP Pro SP2) or AMD64 (Windows® XP Pro 64 SP2) subdirectories. See 
http://h20000.www2.hp.com/bizsupport/TechSupport/SoftwareDescription.jsp?lang=en&cc=us&s
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wItem=MTX-0ef50f2982c344a189375e2745&jumpid=reg_R1002_USEN (http://www.) for more 
information. 

Download the HP NC-Series Multifunction Drivers for RIS/WinPE. For example, for Windows® XP-
64, the b06nd.inf and b06nd51a.sys files are needed for RIS. Add the files and restart RIS. 

7. Connect the target workstation blade to the distribution share per your unattended remote installation 
process, such as boot floppy, RIS, Rapid Deployment Software, or Altiris. 

Example Windows® XP Pro GuiRunOnce script 

The GuiRunOnce script installs the required software and drivers in the proper order, and runs after the 
first boot. A sample version of this script is included in the "HP Workstation Blade Unattended install 
support Files" downloaded in step 3. This script runs after first boot. Create the following script, name it 
"Driver_Software_Install.cmd," and then copy it to $OEM$\$1\HP_Install directory (see [GuiRunOnce], 
step 5e). Modify as needed. 

rem @echo off 

title HP Driver and Software Install Script 

rem Starting - Change Registry Entree for RGS 

         regedt32.exe /s %systemdrive%\HP_Install\forceguest.reg 

         regedt32.exe /s %systemdrive%\HP_Install\FastUserSwitching.reg 

         rem Complete - Change Registry Entree for RGS 

rem Starting XPUnsignOK2.exe to automatically push accept button for 
Unsigned ATI driver 

         echo. 

           echo Starting XPUnsignOK2.exe 

           start 
%systemdrive%\HP_Install\unsignok\XPUnsignOK2.exe 

           echo XPUnsignOK2.exe Started 

rem Starting ATI driver install 

           echo. 

           echo Starting ATI driver install 

           cd %systemdrive%\HP_Install\Drivers\graphics\ATI 

           cpqsetup.exe /s 

         rem Completed ATI driver install 

rem Starting NVIDIA driver install 

         echo. 

         echo Starting NVIDIA driver install 

         cd %systemdrive%\HP_Install\Drivers\graphics\nvidia 

         setup.exe -s -i 

         rem Completed NVIDIA driver install 

echo Installing RGS 

         cd %systemdrive%\HP_Install\RGS\ 

         setup.exe /s 
/f1"%systemdrive%\HP_Install\RGS\ReceiverInstall.iss" 

http://www./�
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         echo Completed Installing RGS 

rem Starting Management Agent install 

          echo. 

          echo Starting Management Agent install 

          cd %systemdrive%\HP_Install\Drivers\management\IMA 

          agents_32.msi /quiet 

          rem Completed Management Agent install 

rem Starting Management Homepage install 

          echo. 

          echo Starting Management Homepage install 

          cd %systemdrive%\HP_Install\Drivers\management\SMH 

          sp36105.exe /s 

         rem Completed Management Homepage install 

rem Changing to USER mode, next reboot) 

rem  Options on this command includes : 

rem     -fsetup.dat : change system to setup mode 

rem     -fuser.dat : change to user mode 

rem     - fadmin.dat : change system to admin mode 

         echo. 

         echo Starting Management Homepage install 

         cd %systemdrive%\HP_Install\conrep 

         conrep.exe -l -fuser.dat -xconrep.xml 

         rem Completed Changing to USER mode, next reboot 

echo. 

echo HP Install Script Complete  

echo. 

echo Init Reboot 

start shutdown -r -t 30 

exit 

Example Windows® XP Pro 64 GuiRunOnce script 

rem @echo off 

title HP Driver and Software Install Script 

rem Starting XPUnsignOK2.exe to automatically push accept button for 
Unsigned ATI driver 

         echo. 

         echo Starting XPUnsignOK2.exe 

         start %systemdrive%\HP_Install\unsignok\XPUnsignOK2.exe 

         echo XPUnsignOK2.exe Started 
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rem Complete XPUnsignOK2.exe to automatically push accept button for 
Unsigned ATI driver 

rem Starting ATI driver install 

         echo. 

         echo Starting ATI driver install 

         cd %systemdrive%\Drivers\ATI 

         cpqsetup.exe /s 

rem Completed ATI driver install 

rem Starting NVIDIA driver install 

         echo. 

         echo Starting NVIDIA driver install 

         cd %systemdrive%\Drivers\NVIDIA 

         setup.exe  -h"1024" -v"768" -b"24" -j"60" -s 

rem Completed NVIDIA driver install 

rem Starting Broadcom driver install 

         echo. 

         echo Starting Broadcom driver install 

         cd %systemdrive%\Drivers\Broadcom 

         cpqsetup.exe /s 

rem Completed Broadcom driver install 

rem Starting Management Agent install 

         echo. 

         echo Starting Management Agent install 

         cd %systemdrive%\Drivers\HP_Insight_Management_Agents 

         cpqsetup.exe /s 

rem Completed Management Agent install 

rem Starting HP Proliant iLO2 Management Controller install 

         echo. 

         echo HP Proliant iLO2 Management Controller install 

         cd %systemdrive%\Drivers\HP_iLO2_Management_Controller 

         cpqsetup.exe /s 

rem Completed HP Proliant iLO2 Management Controller install 

rem Starting HP Proliant iLO Management Interface install 

         echo. 

         echo Starting HP Proliant iLO Management Interface install 

         cd %systemdrive%\Drivers\HP_Proliant_iLO_Management_Interface 

         cpqsetup.exe /s 

rem Completed HP Proliant iLO Management Interface install 

rem Starting System Management Homepage install 
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         echo. 

         echo Starting Management Homepage install 

         cd %systemdrive%\Drivers\HP_System_Management_Homepage 

         cpqsetup.exe /s 

rem Completed Management Homepage install 

rem Starting firewall.cmd to punch holes in firewall (see Appendix C in this 
whitepaper) 

         echo. 

         echo Starting firewall.cmd 

         start %systemdrive%\HP_Install\firewall\firewall.cmd 

         echo firewall.cmd Started 

rem Complete firewall.cmd 

rem Changing to USER mode, next reboot) 

rem  Options on this command includes : 

rem     -fsetup.dat : change system to setup mode 

rem     -fuser.dat : change to user mode 

rem     - fadmin.dat : change system to admin mode 

         echo. 

         echo Starting Management Homepage install 

         cd %systemdrive%\HP_Install\conrep 

         conrep.exe -l -fuser.dat -xconrep.xml 

         rem Completed Changing to USER mode, next reboot 

shutdown -r -t 300 -f 

echo. 

echo HP Install Script Complete  

exit 

Example firewall punch holes script (firewall.cmd) 

netsh firewall add portopening TCP 2381 "HP SMH Secure Web Server (TCP 
2381)" 

netsh firewall add portopening TCP 5988 "WBEM/WMI Mapper (TCP 5988)" 

netsh firewall add portopening TCP 5989 "WBEM/WMI Mapper Secure (TCP 5989)" 

netsh firewall add portopening TCP 22 "SSH port (TCP 22)" 

netsh firewall add portopening TCP 161 "SNMP port 161 (TCP 161)" 

netsh firewall add portopening TCP 162 "SNMP port 162 (TCP 162)" 

netsh firewall add portopening TCP 53 "DNS (TCP/UDP 53)" 

netsh firewall add portopening TCP 67 "DHCP Request (TCP 67)" 

netsh firewall add portopening TCP 68 "DHCP Reply (TCP 68)" 

netsh firewall add portopening TCP 69 "M-TFTP (TCP 69)" 

netsh firewall add portopening TCP 80 "HTTP + ILO (TCP 80)" 
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netsh firewall add portopening TCP 126 "SNMP port 126 (TCP 126)" 

netsh firewall add portopening TCP 137 "Netlogon SMB (TCP/UDP 137)" 

netsh firewall add portopening TCP 401 "WOL (TCP 401)" 

netsh firewall add portopening TCP 402 "RDP dep agents (TCP 402)" 

netsh firewall add portopening TCP 636 "SSL LDAP (TCP 636)" 

netsh firewall add portopening TCP 750 "Active Directory (TCP 750)" 

netsh firewall add portopening TCP 751 "Active Directory (TCP 751)" 

netsh firewall add portopening TCP 752 "Active Directory (TCP 752)" 

netsh firewall add portopening TCP 753 "Active Directory (TCP 753)" 

netsh firewall add portopening TCP 754 "Active Directory (TCP 754)" 

netsh firewall add portopening TCP 1010 "PXEconfig (TCP 1010)" 

netsh firewall add portopening TCP 1433 "SQL (TCP 1433)" 

netsh firewall add portopening TCP 1500 "RPC (TCP 1500)" 

netsh firewall add portopening TCP 1758 "TFTP (TCP 1758)" 

netsh firewall add portopening TCP 1759 "TFTP (TCP 1759)" 

netsh firewall add portopening TCP 2500 "RPC (TCP 2500)" 

netsh firewall add portopening TCP 4011 "External DHCP PXE (TCP 4011)" 

netsh firewall add portopening UDP 123 "SNTP (UDP 123)" 

netsh firewall add portopening UDP 445 "SMB (UDP 445)" 

netsh firewall add portopening TCP 53 "DNS (TCP 53)" 

netsh firewall add portopening UDP 53 "DNS (UDP 53)" 

netsh firewall add portopening TCP 135 "AeXNS+DCOM+SQL (TCP 135)" 

netsh firewall add portopening UDP 135 "AeXNS+DCOM+SQL (UDP 135)" 

netsh firewall add portopening TCP 88 "Kerberos (TCP 88)" 

netsh firewall add portopening UDP 88 "Kerberos (UDP 88)" 

netsh firewall add portopening TCP 389 "LDAP (TCP 389)" 

netsh firewall add portopening UDP 389 "LDAP (UDP 389)" 

netsh firewall set icmpsetting 8 
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User information 

User information introduction 
This chapter is intended for the user of the HP Workstation Blade Solution and describes how to interact 
with the workstation blade from the client computer. The following topics are included in this chapter: 

• Powering on the workstation blade client 

• Changing the behavior of RGS 

• Connecting from the client to the blade 

• Sending Ctrl+Alt+Del to the workstation blade 

• Accessing workstation blade desktop windows 

• Moving desktop windows between monitors 

• Spanning multiple displays with a desktop window 

• Maximizing a window to a single display 

• Supported USB devices 

• Synchronizing a PDA 

• Adjusting audio volume on the client and blade 

• Disconnecting the client from the workstation blades 

• Reconnecting to disconnected sessions 
 

Powering on the HP workstation blade client 
To power on the workstation blade client, press the power button on the blade front panel. The computer 
cycles through a startup sequence in less than a minute and then displays either an Enterprise Directory 
authentication window or the remote display control panel. If a Webmin administration screen appears, 
your client has not been properly configured. Contact your administrator for assistance. 

 

Changing the behavior of RGS 
You might have to change the behavior of RGS. This is done using the RGS Receiver Control Panel, the 
Remote Display Window Toolbar, or the Virtual KVM. The Receiver Control Panel enables you to change 
all connections between a client and one or more blades. The Remote Display Window Toolbar controls 
only a single connection. The Virtual KVM allows switching between connections in situations where you 
have more display area on your blades than you have monitors on the client. For more information about 
configuring RGS, see the HP Remote Graphics User's Guide. 

The RGS Receiver must be in Setup Mode (where keyboard and mouse input are directed to the RGS 
Receiver) to access the RGS controls. When the RGS Receiver is in Setup Mode, the display fades to gray 
as a visual queue. Setup Mode is activated by entering certain key sequences while the RGS Receiver 
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window is selected. By default, the key sequence to enter Setup Mode is press Shift, press Space, and 
release Space (or, more simply, hold down the Shift key, then press and release the Space bar). When in 
Setup Mode (while still holding the Shift key), you can: 

• Press the M key (Setup Mode + M) to display the Receiver Control Panel. 

• Press the H key (Setup Mode + H) to display the Remote Display Window Toolbar. 

• Press the Tab key to access the Virtual KVM. 

If these key sequences do not work, contact your administrator. 
 

Connecting from the client to the blade 
RGS connects the client computer to the workstation blade. Under typical circumstances, connecting to 
your blade from the client computer is as simple as clicking the Connect button, or entering an IP address 
and clicking Connect. However, RGS is a highly configurable product, and your administrator can assign 
workstation blades to the client in three ways: 

• Enterprise Directory 

• Local directory file 

• Manual entry 

The following sections describe the default behavior of RGS during the login process, and outline which 
behaviors can be modified by your administrator. Contact your administrator if you are unsure which of 
the following modes is used in your client environment. 

 

Using Enterprise Directory 
This section assumes that your organization has implemented an Enterprise Directory Service and your 
administrator has assigned a workstation blade to you through this service. If this is not the case, contact 
your administrator for the hostnames or IP addresses of the blades assigned to you. 

(Default) If you are using Enterprise Directory, after powering up the client system, an Enterprise Directory 
authentication window appears. Enter your user name and password in the indicated boxes, and click 
OK. In many environments, you must provide a Microsoft® Windows® domain for authentication. In this 
case, enter domain\username in the User Name box. For example, a user named "mhsmith" in the 
"Americas" domain will enter Americas\mhsmith in the User Name box. If you are unsure whether 
domain authentication is used at your site, contact your administrator. 

After you enter your login information, the Windows login screen (from the blade) appears on the client 
display. You can interact with the Windows screen in much the same way as a PC or workstation. 

(Variation) If there are different user names set up on your assigned blade, click the General tab on the 
RGS control panel and then select Prompt for username and password. This will allow different user 
names to be entered for each blade, and each connection will be authenticated separately. 

(Variation) If your organization has implemented Single Sign-on with RGS, the only authentication prompt 
(username and password) displayed is from the RGS Receiver on the client. After authentication by the 
RGS Receiver, the blade Windows desktop is displayed, logged-in and ready to use. 
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Using a local directory file 
Setting up the Enterprise Directory may not be practical for smaller installations. Instead, it may be more 
efficient to use a directory file that resides on the client. The directory file contains a list of systems 
assigned to authorized users on that client. For details on the content of the directory file, see the HP 
Remote Graphics User's Guide. 

(Default) You will be asked for your username and password twice for each blade-once from RGS to 
authenticate the connection, and once by Windows® for login authentication. Enter your user name and 
password in the indicated boxes and click OK. In many environments, you must provide a Windows 
domain for RGS connection authentication. In this case, enter domain\username in the User name box. 
For example, a user named "mhsmith" in the "Americas" domain will enter Americas\mhsmith in the User 
name box. If you are unsure whether domain authentication is used at your site, contact your 
administrator. 

(Variation) If the administrator has enabled RGS Easy Login, you'll see only the standard Windows login 
screen for each assigned blade. Log into Windows as you normally would. 

If your organization has implemented Single Sign-on with RGS, the only authentication prompt (username 
and password) displayed is from the RGS Receiver on the client, and it is displayed only once. After 
authentication by the RGS Receiver, the blade Windows desktop is displayed, logged-in and ready to 
use. 

 

Using manual entry 
If the Enterprise Directory or the local directory file is not used at your site, you will need to manually enter 
the name or IP address of your assigned blade. A local administrator can provide this information. Only a 
single blade can be accessed from each client using manual entry. 

(Default) From the RGS control panel, enter the name or IP address of your assigned blade in the 
Hostname box. Depending on how your local network is configured, the system name could be short (for 
example, "willard") or long (for example, "willard.fc.hp.com"), or you might need to enter the IP address 
of your assigned blade (for example, 10.10.24.145). Enter the name or address of the blade in the box 
and click Connect. If the system is operational, you will see a connection authentication window with 
"Authenticate to <system name>" in the title bar. 

Enter your user name and password in the indicated boxes, and click OK. In many environments, you 
must provide a Windows domain for authentication. In this case, enter domain\username in the User 
name box. For example, a user named "mhsmith" in the "Americas" domain will enter Americas\mhsmith 
in the User name box. If you are unsure whether domain authentication is used at your site, contact your 
administrator. 

After entering your login information, the Windows login screen (generated from the blade) appears on 
the client display. You can interact with the Windows screen in much the same way as a traditional PC or 
workstation. 

(Variation) If the administrator has enabled Easy Login on the blade, there will be no RGS connection 
authentication window. The Windows login or lock screen appears on the client. In this case, just log into 
Windows as you normally would. 

(Variation) If your organization has implemented Single Sign-on, the only authentication prompt 
(username and password) displayed is from the RGS Receiver on the client. After authentication by the 
RGS Receiver, the blade Windows desktop of the blade is displayed, logged-in and ready to use. 
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Sending Ctrl+Alt+Delete to the workstation blade 
Using Ctrl+Alt+Delete, you can log in, access the Windows® Task Manager, or lock the desktop. If you 
are accessing a workstation blade from the following clients, the process is identical to a desk side 
system-the Ctrl+Alt+Delete key sequence is forwarded directly to the blade: 

• HP Workstation Blade Client 

• HP dc72 Workstation Blade Client 

• HP dc73 Workstation Blade Client 

If you are using a client running Microsoft® Windows®, Ctrl+Alt+Delete is intercepted by the Windows® 
operating system. When this happens, the Microsoft® Windows® Security screen is generated by the 
client computer, not by the workstation blade. If this occurs: 

1. Click Cancel. 

2. Open the RGS Remote Display Window Toolbar, select Changing the behavior of RGS, and then 
click the Ctrl+Alt+Del button. 

You can also use the alternate sequence, Ctrl+Alt+End, from a Microsoft® Windows® client. If this 
sequence is disabled in RGS, enable it: 

1. Open the RGS Control Panel (Setup Mode + M). 

2. Click the Advanced button. 

3. Click the Hotkeys tab. 

4. Select Send CTRL-ALT-END key sequence as CTRL-ALT-DEL. 
 

Accessing workstation blade desktop windows 
If your client computer is configured with four monitors, you can have as many as four active desktop 
windows from four workstation blades displayed simultaneously at full resolution on your client computer. 
Assuming your client computer has been properly configured, the mouse pointer should move logically 
from one monitor to the next as if the display area is one large monitor. To access the desktop of a 
particular workstation blade, move the mouse pointer to that desktop area. 

If the aggregate display area of your workstation blades exceeds the display area provided by the 
monitors on your desk (such that one blade display covers another), you can use the RGS Virtual KVM to 
bring forward the desktop window by choosing one of the following methods: 

o Method 1 

a. Enter Setup Mode. 

b. Press the Tab key. A window appears on the desktop showing a thumbnail view of each desktop.  

c. Use the Tab key to highlight the desired desktop, and then release the Setup Mode key. 

o Method 2 

a. Enter Setup Mode. 

b. Press a number key corresponding to the desired blade. 
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Moving desktop windows between monitors 
RGS enables you to move desktop windows to any part of the client screen space. If the desktop windows 
sent from the workstation blade have borders, click the top border and drag the desktop to the desired 
location. If the desktop windows do not have borders, perform the following steps to move a window: 

1. Enter RGS Setup Mode. 

2. While holding the system in Setup Mode (by default, continue to hold the Shift key down), click 
anywhere on the desktop, and drag the window to the desired location. 

3. Release the mouse button and Shift key. 

To simplify the alignment of desktop windows with monitors, the RGS Receiver has a "snap" feature that 
performs the alignment automatically when a desktop window is positioned close to the edge of a 
monitor. If the snap feature is not working, bring up the Receiver Control Panel and click the button. 

 

Spanning multiple displays with a desktop window 
The workstation blade NVIDIA graphics adapter supports a large display area (up to 4x2500x1600). 
The client computer automatically adjusts its display area to accommodate the blade desktop window, 
limited by the number and resolution of the monitors. For example, you might want a single workstation 
blade desktop window to span two client monitors, each with a 1280x1024 resolution, placed side-by-
side. The process to size the blade desktop window is the same as changing the display resolution on a 
traditional PC or workstation running Windows® XP: 

1. Right-click in an open space in the workstation blade desktop window, and then select Properties. 

2. Click the Settings tab. 

3. Under the Settings tab, adjust the screen resolution slider to 2560x1024, and then click OK. 

The desktop window now spans two monitors. If the desktop window starts on the right-most monitor, 
move the desktop window to the left-most monitor to view it in its entirety. 

 

Maximizing a window to a single display 
If the workstation blade desktop window is set to span multiple monitors, every window that you 
maximize within the desktop window also spans multiple monitors. However, this behavior might not be 
desirable. The graphics driver SoftPaq supplied by HP includes an NVIDIA tool, nView, that enables you 
to change the setting so a maximized window fills only one monitor. To change the setting, perform the 
following steps: 

1. Change the resolution from 1600x1200 to 2560x1024. 

2. Identify monitors (displays 1). 

3. Go to the Desktop Management tab, select Disable, and then Enable. 

4. Go to the Windows tab, and identify monitors (displays 1). 

5. Save settings, and then exit nView. 

6. Re-enter nView. 

7. Go to the Windows tab, and identify monitors (displays 1). 

8. Log out. 

9. Log in. 
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10. Re-enter nView. 

11. Go to Windows tab, identify monitors (should display 1a 1b). 

Test the new setting by maximizing a window. If configured properly, the maximized window fills only 
one monitor. The nView option supports other customizations in the Windows® environment as described 
in the ForceWare Graphics Driver nView Desktop Manager User Guide included with the NVIDIA 
graphics driver SoftPaq. 

 

Supported USB devices 
RGS supports remote USB, which allows USB devices connected to the client computer to be remotely 
attached to the workstation blade. Remote USB is described in the HP RGS User Guide available at 
http://www.hp.com/support/rgs_manuals (http://www.hp.com/support/rgs_manuals). This document 
also lists the client-attached USB devices which can be attached to the RGS Sender (the workstation 
blade).  

 

Synchronizing a PDA 
The virtual USB port currently supports PDA synchronization operations. Before synchronizing a PDA, you 
must first load your PDA synchronization software on one of your blades. Contact your administrator if the 
software has not been loaded. 

To synchronize your PDA: 

1. Open the RGS Control Panel (Setup Mode + M). 

2. Click the Advanced button. 

3. Click the USB tab. 

4. Select the Enable USB checkbox, and then select from the list the blade where the USB traffic will be 
directed. 

5. Attach the PDA cradle to one of the USB ports on the workstation blade client, then place the PDA in 
the cradle. 

6. Follow the PDA manufacturer instructions for synchronizing the PDA on a standard Microsoft® 
Windows® XP desktop system. 

 

Adjusting audio volume on the client and blade 
The workstation blade solution provides three audio adjustments: 

• Adjust volume on a specific blade—Use Microsoft® Windows® Control Panel (click Start > Control 
Panel > Sounds and Audio Devices). When you adjust the audio volume on a blade using 
Windows® Control Panel, the Mute button in the Microsoft® Windows® XP volume control does not 
function.  

• Adjust volume on multiple blades—Use the volume control and mute button on the RGS Control 
Panel. Open the RGS Control Panel (Setup Mode + M). If you do not hear audio, click the Mute 
button, and then move the volume slider (triangular wedge next to the mute button) to the right to 
increase to volume. Adjusting the volume at the client affects all blades, and muting audio at the 
client mutes all audio from the blades. This change is not shown on individual Microsoft® 
Windows® XP desktops. 

http://www.hp.com/support/rgs_manuals�
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You can also use the RGS Control Panel to select between stereo and monaural audio, and choose 
the sound quality level, from Low (AM radio) to High (full CD-quality). From the RGS Control Panel, 
click the Advanced button, and then click the Audio tab. 

Higher-quality and stereo sound increase network bandwidth usage. 

• Adjust volume on the client desktop only—Right-click the client desktop to access the Audio Control 
Panel. This method is useful for adjusting the volume on your headphones and muting speakers 
without changing blade volume levels. Select the output port (front jack, rear jack, or speaker) with 
the left and right arrow keys, and adjust the volume with the up and down arrow keys. Use the M 
key to mute a device. 

If you mute the primary speaker on the workstation blade client and then adjust the volume from the 
RGS Control Panel, the speaker might not be muted. For this reason, HP recommends that you 
establish volume settings on the workstation blade client and RGS Control Panel, and then manage 
the audio from the individual blades using standard Windows® tools. 

 

Disconnecting the client from the workstation blades 
To disconnect a client from all blades, open the RGS Control Panel (Setup Mode + M), and then click the 
Disconnect button. To disconnect a client from an individual blade, open the Remote Display Window® 
Toolbar (Setup Mode + H), and click the Disconnect button. 

When you end a client RGS session, the workstation blade enters Disconnected mode. All workstation 
blade processes continue to run, and the display state is maintained. Sessions are also disconnected 
when you log out of Microsoft® Windows® on the workstation blade. 

You can reboot the blade by clicking start>Shut Down. You can also reboot by pressing Ctrl+Alt+Del, and 
then selecting Restart in the Task Manager. 

During the reboot, the blade connection to the client is lost (there might be a small timeout lag). There is 
no indication on the client when Windows® starts up on the blade and the blade is available for login. 

HP recommends that you not turn off the blade from the Windows® XP desktop (for example, by selecting 
Turn Off in the menu). Doing so would require administrator intervention to restart the machine. 

HP recommends that you not select a power-saving state (such as Standby or Hibernate). Doing this would 
require administrator intervention to bring the system back online. 

 

Reconnecting to disconnected sessions 
If network connectivity is lost for more than a few seconds, or power to the client is interrupted, it is likely 
that the RGS connection from the client to one or more blade desktop sessions will be lost. RGS keeps the 
Windows® XP sessions active on the workstation blades (assuming they are still running). 

Upon resumption of the network connection, open the RGS Control Panel on the client (Setup Mode + M), 
and click the Connect button. All blades that were disconnected are re-connected at the state they were in 
when the connection was lost.  

In case of a client power interruption, press the Power button when power is restored. Wait for the client 
to boot, and then reconnect. 
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Managing the workstation blade 

Workstation blade management overview 
This chapter describes how to manage workstation blades, and includes information on the following 
topics: 

• Onboard Administrator 

• Integrated Lights-Out 2 (iLO 2) 

• Remote Desktop Connection 

• System Management Homepage 

• HP SIM 

• HP Rapid Deployment Pack 

• HP Insight Diagnostics 

• ROM-based Setup Utility 

• BIOS programming 

• POST 

The workstation blade design is based on the design of the corresponding server blade, and most of the 
manageability features are common between workstation blades and server blades. The following 
documents contain information about the manageability of the systems: 

• HP ProLiant BL460c Server Blade User Guide 

• HP BladeSystem c7000 Enclosure Setup and Installation Guide 

• HP BladeSystem c3000 Enclosure Setup and Installation Guide 

• HP BladeSystem c3000 Tower Enclosure Setup and Installation Guide 

• HP BladeSystem Onboard Administrator User Guide 

• HP Integrated Lights-Out 2 User Guide 
 

Onboard Administrator 
OA enables you to use a web browser to remotely log in to OA and obtain detailed information about 
the contents of each c7000 Enclosure. 

Using OA, you can determine the following: 

• A workstation blade is installed in each device bay. 

• Workstation blades are powered on as indicated by the green lights. 

• Four power supplies are installed in the enclosure. 

• Two network interconnect devices are installed in the rear of the enclosure. 
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• One OA module is installed in the rear of the enclosure. 

OA also provides detailed information about each blade in the enclosure. 

The iLO 2 management processor also supports blade power management. However, using iLO 2 power 
management requires a separate login to iLO 2 on each blade. With OA, you can manage power for 
blades from a single OA login session. 

OA modules in the rack are linked together with Ethernet cables, allowing administrators to view and 
control the blades in every enclosure by logging into the OA module in any enclosure. OA also includes 
the Insight Display, which enables administrators to locally view and control the blades. 

 

Integrated Lights-Out 2 (iLO 2) 
The iLO 2 feature enables administrators to remotely perform most workstation blade management 
functions that otherwise would require a visit to the blades. For example, iLO 2 enables administrators to 
remotely: 

• Change BIOS settings 

• View the boot process 

• Validate that Windows® starts up correctly (in Admin Mode and Setup Mode) 

• Install software 

Many iLO 2 capabilities require that Remote Console Mode is set to Admin Mode. In Admin Mode, the 
Windows® desktop is viewable using iLO 2. In User Mode, the Windows® desktop can only be viewed 
using RGS or Remote Desktop Connection. 

 

Accessing iLO 2 
The most common way to access iLO 2 is from a web browser pointed to the iLO 2 IP address (using 
HTTPS). After logging into iLO 2, the status summary screen is displayed. 

 

iLO 2 Remote Console 
The iLO 2 Remote Console enables you to remotely view and interact with the boot console and the 
Windows® desktop (in Admin Mode and Setup Mode). To view the Remote Console types, select the 
Remote Console tab. 

The Remote Console capability of iLO 2 is not the same as the Remoter Console Mode BIOS setting. 

The Integrated Remote Console displays the boot console. This enables you to remotely interact with the 
boot process in the same manner as when a monitor, keyboard, and mouse are connected directly to the 
blade. 

 

Viewing the Windows® desktop 
If Remote Console Mode is set to Admin Mode or Setup Mode, the Windows® desktop is generated by 
the ATI video controller and is viewable through the iLO 2 Remote Console. 

During normal use, Remote Console Mode is set to User Mode, which means that the Windows® desktop 
is generated by the NVIDIA graphics adapter. In this case, the iLO 2 Remote Console (which is generated 
by the ATI video controller) goes blank after Windows® starts up. 



 

Managing the workstation blade 51 

If you press Ctrl+Alt+Del on the keyboard of the PC that displays the iLO 2 Windows® desktop, your PC 
will respond, not the blade. The iLO 2 Remote Console provides the Ctrl+Alt+Del button, which sends this 
keystroke combination to the blade. 

The Ctrl+Alt+Del button is located at the top of the Windows® desktop remote screen. 
 

iLO 2 virtual media 
The iLO 2 Virtual Media screen allows you to connect a floppy drive, USB key, or CD/DVD drive to the 
workstation blade from your local PC. To create this connection, perform the following steps: 

1. Click the iLO 2 Virtual Devices tab. 

2. Click the Virtual Media link. 

3. Select the media on your PC to connect to the workstation blade, and then click the Connect button. 

To verify that the virtual media is connected to the blade, you can use RGS to run Windows® Explorer on 
the blade. 

Local image files on the PC can also be connected to the workstation blade by selecting Local Image File 
under Virtual Floppy/USB Key or Virtual CD/DVD-ROM, and providing the file name. 

The Integrated Remote Console can also be used to mount local drives, folders or images from the PC to 
the workstation blade. 

 

Remote Desktop Connection 
Microsoft® RDC provides a convenient way to remotely administer the workstation blade because it 
allows the administrator to use the familiar Windows® interface. 

RDC and RGS are not interoperable. If an RDC connection is made while an RGS session is established, 
the blade RGS Sender disconnects and the RGS session terminates. After the RDC connection terminates, 
the RGS Sender resumes automatically, and users can connect to the blade with RGS. For more 
information, see the RGS User Guide. 

Prior to RGS 5.1.3, RDC could not be used to remotely install RGS. For RGS 5.1.3 and later, RDC can be 
used to install RGS. 

In RDC connection is made using the following steps: 

1. To start Remote Desktop Connection, click Start > Accessories > Communications > Remote Desktop 
Connection. 

RDC displays a dialog box for entry of the workstation blade NIC1 or NIC2 IP address. 

2. Click Connect. The Remote Desktop window appears with the Log On to Microsoft® Windows® 
screen. After logging in, the Windows® desktop appears. 

 

System Management Homepage 
This section describes how to view the blade SMH. SMH enables you to view information generated by 
the four blade management agents: NIC, server, storage, and foundation. To access SMH, point your 
browser to either of the blade IP addresses (NIC1 or NIC 2) using HTTPS and port number 2381. 

If your credentials are correct, but you cannot log in to SMH, make the following change to the blade 
security options: 
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1. Go to Control panel > Administrative Tools > Local Security Policy > Security Options. 

2. Ensure that Network Access: Sharing and security model for local accounts is set to Classic - local 
users authenticate as themselves. This setting is also required for RGS operation, and might have 
already been set. 

After logging in, the Overall System Status page appears. 
 

Local access to SMH 
If you have a monitor, keyboard, and mouse connected to the Local I/O Cable, you can view SMH using:  

• Either of these URLs: https://127.0.0.1:2381 (https://127.0.0.1:2381) or https://localhost:2381 
(https://localhost:2381). 

• The Start menu by clicking Start > All Programs > HP Management Agents > HP System Management 
Homepage, which opens a browser window pointed to https://127.0.0.1:2381 
(https://127.0.0.1:2381). 

 

HP SIM 
The workstation blade is designed to work with HP SIM. If you created a custom Windows® image, 
ensure that SNMP and the HP Insight Management Agents for Windows are installed. 

 

HP Rapid Deployment Software 
HP Insight Rapid Deployment Software is a deployment solution that facilitates the installation, 
configuration, and deployment of high volumes of workstation blades through either a GUI-based or web-
based console. Rapid Deployment Software is designed to automate repetitive tasks such as configuring 
and deploying operating system images, configuring network switches, and configuring BIOS settings. 
System configuration time is reduced, making it possible to rapidly scale workstation blade deployments 
to high volumes. 

This section focuses primarily on image capture and image deployment techniques using Rapid 
Deployment Software for the workstation blade. 

 

HP Insight Rapid Deployment Software content 
Rapid Deployment Software is based on Altiris Deployment Solution (DS) technology. Functionality 
specific to HP ProLiant Systems is added by the ProLiant Integration Module (PIM)-a collection of scripts 
that have been predefined for ProLiant systems to perform routine tasks. Interaction with Altiris DS occurs 
in a GUI or web-based environment called the Deployment Server Console. The DS Console provides a 
drag-and-drop interface for assigning jobs to computers (drag computer to job or job to computer). 
Toolbar buttons provide shortcuts to common Altiris DS tasks. 

 

Infrastructure requirements 
Rapid Deployment Software requires the following:  

• DHCP server 

• PXE server 

https://127.0.0.1:2381/�
https://localhost:2381/�
https://127.0.0.1:2381/�
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• Altiris Deployment Solution 

• A database-either Microsoft® SQL Server or Microsoft® Data Engine (MSDE) 
 

Rapid Deployment Software-specific differences between server 
blades and workstation blades 

There are several differences between server blades and workstation blades that affect HP RDP: 

• The operating systems are different. 

• The workstation blade operating system is preinstalled on the hard drive. 

• The workstation blade boots differently from the server blade. 

• The server blade supports several software tools not supported by the workstation blade. 

These differences combine to limit some HP RDP functionality for the workstation blade, as described in 
the following sections. 

 

Operating system 
Windows® XP-32 the workstation blade differs from Windows Server® on the server blade in several 
ways that affect how an administrator uses HP RDP: 

• HP RDP versions prior to version 3.82 do not support scripted installs on Windows® XP—To deploy 
Windows® XP-32 the workstation blade using HP RDP prior to version 3.82, the administrator must 
create a reference image, outside of HP RDP, and then deploy that image to target systems using the 
Image Capture and Image Deployment features of HP RDP. HP RDP 3.82 and higher support 
scripted installs on Windows® XP-32. 

• Windows® XP uses Microsoft® Windows® Activation technologies—Microsoft® Windows® 
Activation requires either that users activate their Windows® license on each machine at first boot or 
that the administrator take specific steps during image creation to ensure that activation is not 
needed. Microsoft® Windows® Activation is not required on the server blade. 

 

Booting 
The workstation blade boot process differs from the server blade boot process in two ways: 

• The workstation blade boots from the hard drive. Booting from the hard drive occurs because there is 
an OS installed on the hard drive. With the server blade, PXE booting occurs because there is no 
OS installed. If PXE booting is required on the workstation blade, the administrator will need must 
use the iLO 2 remote console to force PXE booting to occur. 

• The workstation blade is shipped with Remote Console Mode set to User Mode. This is desirable for 
most systems because RGS, using the NVIDIA graphics adapter, offers better performance than the 
ATI video controller. However, because the RGS is not preinstalled on the operating system image, 
the administrator might need to set Remote Console Mode to Admin Mode to create the reference 
image. 

 

Software tools 
• ProLiant Support Packs are not currently supported on the workstation blade. 
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• The SmartStart Scripting Toolkit is not supported on the workstation blade. In particular, the 
Conrep.exe tool and server deployment jobs that capture firmware settings (for example, the default 
Hardware Configuration or Server Deployment jobs) do not capture settings for features that are 
unique to the workstation blade, such as Remote Console Mode. These settings must be configured 
using iLO 2 or the local I/O cable. 

 

Using Rip-n-Replace and Virtual Bay features to replace failed 
systems 

Both the Rip-n-Replace and the Virtual Bay functionality of the blade systems architectures should also 
function on workstation blades. However, a new system placed into the Virtual Bay is not detected until it 
is either PXE booted or booted with an image that has the A-client installed and configured. Automatic 
deployment jobs are then enabled. The default for the workstation blade is to boot to the Windows® XP 
Professional image preinstalled on the hard drive, which does not have the A-client installed or 
configured. 

 

HP Insight Diagnostics 
The HP Insight Diagnostics utility enables you to perform and view critical computer hardware and 
software configuration information from various sources. This utility enables you to run diagnostics and 
view the hardware configuration of the system. 

As noted below, the HP Insight Diagnostics are available on the Documentation and Diagnostics CD that 
is included with your workstation blade. The server version of these diagnostics, available on the 
SmartStart CD, is not supported on the workstation blade. 

 

Key features and benefits 
HP Insight Diagnostics simplifies the process of identifying, diagnosing, and isolating hardware issues. In 
addition to robust management tools, service tools can be invaluable for quickly resolving system 
problems. To streamline the service process and resolve problems quickly, you must have the right 
information available at the time a service call is placed. The primary information requirement, which is 
also the one that provides the greatest insight into potential system issues, is the system configuration. 

Uses of Insight Diagnostics include: 

• Testing and diagnosing apparent hardware failures 

• Documenting system configurations for upgrade planning, standardization, inventory tracking, 
disaster recovery, and maintenance 

• Sending configuration information to another location for in-depth analysis 
 

Theory of operation 
HP Insight Diagnostics Offline Edition operates in offline mode only-the operating system is not running, 
and information from the operating system is not available to the diagnostics. Offline Survey is available 
to display the current system configuration. 

The Insight Diagnostics Test feature enables you to test functionality of all the major hardware components 
in the system. This feature is flexible to enable you to customize test selections by providing different 
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modes and types of testing. It includes Quick, Complete, and Custom testing levels to give you control 
over testing depth and required user interaction. 

 

Accessing HP Insight Diagnostics 
HP Insight Diagnostics is available on the Documentation and Diagnostic CD included with your 
workstation blade. To start the diagnostic utility on the CD: 

1. Power on your workstation, and then press the F10 key during the initial boot process to enter the 
Computer Setup utility. 

2. Select your language from the list, and then press the Enter key. In the Computer Setup Utilities 
menu, four headings appear: File, Storage, Security and Advanced. Other headings might appear 
depending on the workstation. 

3. Use the right arrow key to select Storage. 

4. Use the down arrow key to select Boot Order, and then press Enter. 

5. Select CD/DVD drive, and then enable it as a bootable device by pressing the F5 key. If not already 
enabled, pressing the F5 key again disables the device. The default setting is enabled. 

6. Set the CD/DVD drive to the top of the boot order. Select CD/DVD, press the Enter key, and then use 
the up arrow to move it to the top of the boot order. 

7. To apply and save changes, press the F10 key, and then select File>Save Changes and Exit. 

8. Insert the Documentation and Diagnostic CD into the workstation. 

9. Restart the blade. HP Insight Diagnostics launches. 
 

Survey tab 
The Survey tab displays system configuration information. In the View section on the left side of the 
screen, you can select the Summary view to see limited configuration data or select the Advanced view to 
see the data in the selected category. The following categories of information are available on the Survey 
tab:  

• All—Provides a listing of all categories of information about the computer. 

• Overview—Provides a listing of general information about the computer. 

• Architecture—Displays the type of bus the computer uses and BIOS information. In addition, if the 
bus is a PCI, information about the PCI configuration appears. 

• Asset Control—Displays asset tag, system serial number, and processor information. 

• Communication—Displays information about the computer parallel port (LPT) and serial port (COM) 
settings, and USB and network controller information. 

• Graphics—Displays information about the graphics controller of the computer. 

• Input Devices—Displays information about the keyboard, mouse, and other input devices connected 
to the computer. 

• Memory—Displays information about all memory in the computer. This includes memory slots on the 
system board and any memory modules installed. 

• Miscellaneous—Displays information obtained from the computer configuration memory (CMOS), 
system management BIOS data, system board data, and diagnostics component information. 
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• Storage—Displays information about storage media connected to the computer. This list includes all 
fixed disks, diskette drives, and optical drives. 

• System—Displays information about the system board, processor, chassis, and BIOS, plus internal 
speaker and PCI bus information. 

 

Test tab 
The Test tab enables you to choose various parts of the system to test. You can also choose the type of test 
and testing mode. There are three types of tests to choose from: 

• Quick Test—Provides a predetermined script for which a sample of each hardware component is 
tested. Quick Test requires no user intervention in either Unattended or Interactive mode. 

• Complete Test—Provides a predetermined script in which each hardware component is fully tested. 
You can select Interactive or Unattended tests, which will change the devices tested during the 
Complete Test. Most tests are available in Interactive mode but require user intervention.  

• Custom Test—Provides the most flexibility in controlling testing. Custom Test mode enables you to 
specifically select which devices, tests, and test parameters are run. You can select tests that do not 
require any user interaction using the Interactive or Unattended test modes. More tests are available 
in Interactive mode but require user intervention. 

To begin testing: 

1. Click the Test tab. 

2. Select Type of Test to perform, and then select Interactive or Unattended as the test mode.  

3. Determine how you want the test to be executed. 

a. Select Number of Loops, and then enter the number of loops to perform. 

b. Select Total Test Times, and then enter the amount of time in minutes that you want the diagnostic 
test to run. 

When choosing to run the test over a specified number of loops, enter the number of loops to 
perform. If you want to run the diagnostic test for a specified time period, enter the amount of 
time in minutes. 

4. Click Begin Testing in the lower right corner of the display to start the test. 

While tests are being performed, you can monitor the progress by clicking the Status tab. Any errors that 
are detected are summarized in the Error Log. Click Save to save the report to a diskette or a USB key 
drive (if attached). 

If the diagnostics utility detects an error during a test, you can mouse-over the failed text in the Status tab 
to display additional information about the type of error and the error code. 

To view all test failure information, select Error Log. To view the status of all testing that has been 
performed, click the Log tab. 

 

Status tab 
The Status tab displays the status of selected tests. The type of test executed (Quick, Complete, or Custom) 
also appears. The main progress bar displays the percent complete of the current set of tests. While 
testing is in progress, a Cancel Testing button is available if you want to cancel the test. 

After testing is complete, the Cancel Testing button is replaced with two buttons, Select New Tests and 
Retest. To return to the previous test selection page to select a new set of tests, click the Select New Tests 
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button. To run the last set of tests executed without having to return to the test selection page, click the 
Retest button. 

The Status tab also displays: 

• Devices being tested 

• Tests that are running 

• Overall elapsed time 

• Individual elapsed test times 

• Condition status of each test 
 

Log tab 
The Log tab displays two types of logs: 

• Test Log—Displays all tests that have been executed, number of times the tests were executed, 
number of times the tests failed, and the time it took to complete the tests. To clear the contents of the 
Test Log, click the Clear Test Log button. 

• Error Log—Displays the tests that have failed during diagnostic testing. In addition to displaying the 
devices and tests, this section can also include error details. The description section describes the 
errors found by the diagnostic tests. To view a recommended action to resolve an error, click the 
Recommended Repair button. The error count is the number of times the test has failed. To clear 
contents of the Error Log, click the Clear Error Log button. 

 

Help tab 
The Help tab has three views: 

• HP Insight Diagnostics—Provides introductory and detailed information about Insight Filed 
Diagnostics. 

• Error Codes—Provides error code listings, including device tested, messages, and recommended 
repair information. 

• Test Components—Reloads and refreshes all components and displays component details after the 
refresh. 

The Help tab provides the following options: 

• Reload—Located in the upper-right corner of the display, this selection reloads all hardware 
components. 

• About—Provides Insight Diagnostics revision details. 

• Exit—Located in the lower-left corner of the screen, this selection provides the option to exit 
diagnostics. 

 

Saving and printing information in HP Insight Diagnostics 
You can save information displayed in the HP Insight Diagnostics Status and Log tabs to a diskette or USB 
2.0 drive key (64MB or higher). You cannot save this information to the hard drive. The system 
automatically creates an html file that looks the same as the information displayed on the screen. 

1. Insert a diskette or USB 2.0 drive key (capacity must be 64MB or higher). USB 1.0 drive keys are 
not supported. 
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2. Click Save in the upper right corner of the tab. 

3. Select Save to the floppy or Save to USB key. 

4. Enter a file name in the File Name box, and then click the Save button. An html file is saved on the 
diskette or USB drive key. 

5. Print the information from the diskette or USB drive key. 

To exit HP Insight Diagnostics, click Exit in the upper-right corner of the screen, and then remove the 
Documentation and Diagnostics CD from the optical drive. 

 

Downloading the latest version of HP Insight Diagnostics 
1. Go to http://www.hp.com (http://www.hp.com). 

2. Click the Support & Drivers link. 

3. Select the Download driver and software radio button. 

4. Enter your product number (for example, WS460c) in the text box, and then press the Enter key. 

5. Select your operating system. 

6. Click the Diagnostic link. 

7. Locate HP Insight Diagnostics, and then click Download. 

The download includes instructions for creating a bootable CD. 
 

ROM-Based Setup Utility 
The RBSU enables BIOS parameters to be changed during the boot process. For example, Remote 
Console Mode is set using RBSU. For details on RBSU options, see the HP ROM-Based Setup Utility User 
Guide on the HP website http://www.hp.com/support/xw460c (http://www.hp.com/support/xw460c). 

You must make the following RBSU settings: 

• HP Graphics Expansion x16 mode--This mode is enabled only with a WS460c Graphics Expansion 
Blade. This mode enables the PCIe Generation 2 x16 connections between the blade and the 
graphics adapters. This mode is disabled for workstation blades without the Graphics Expansion 
Blade. 

To set HP Graphics Expansion x16 mode, select System Options>HP Graphics Expansion x16 mode. 

o If you are using the Graphics Expansion Blade, click Enable.  

o If you are not using the Graphics Expansion Blade, click Disable.  

• PCIe Generation 2—This setting is enabled only with a WS460c Graphics Expansion Blade. This 
setting enables the Graphics Expansion Blade to work at a higher level than the PCIe Generation 1 
setting.  

To set PCIe Generation 2, select Power Management Options>Advanced Power Management 
Options>PCI Express Generation 2.0 Support>Force PCIe Generation 2. 

 

Power-on Self Test 
At power-on, the workstation blade performs POST. 

 

http://www.hp.com/�
http://www.hp.com/support/xw460c�
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BIOS Serial Console 
BIOS Serial Console allows you to configure the serial port on the local I/O cable to view POST error 
messages and run RBSU. A keyboard and mouse are not required. 

 

BIOS programming 
HP provides a downloadable SoftPaq to update the BIOS. Each BIOS SoftPaq includes a version number 
and date. If there is a more recent BIOS version available than the BIOS on your workstation blade, HP 
recommends that you update to the latest BIOS. 

The BIOS version is not dependent on the operating system that you are using. A common BIOS can 
support Windows® XP-32 and Windows® XP-64. 
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Acronyms and abbreviations 

BACS 
Broadcom Advanced Control Suite 

 

BBWC 
battery-backed write cache 

 

BIOS 
Basic Input/Output System 

 

DHCP 
Dynamic Host Configuration Protocol 

 

DIMM 

dual inline memory module 
 

DNS 

domain name system 
 

DVI 

digital visual interface 
 

FEC 

Fast EtherChannel 
 

GEC 

Gigabit EtherChannel 
 

HP SIM 
HP Systems Insight Manager 

 

HTTP 
hypertext transfer protocol 

 

HTTPS 
hypertext transfer protocol secure sockets 
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I/O 

input/output 
 

iLO 2 

Integrated Lights-Out 2 
 

KVM 

keyboard, video, and mouse 
 

LACP 

Link Aggregation Control Protocol 
 

LAN 
local-area network 

 

NIC 
network interface controller 

 

OA 
Onboard Administrator 

 

OOBE 
out of box experience 

 

OS 

operating system 
 

PCI Express 

Peripheral Component Interconnect Express 
 

PDU 

power distribution unit 
 

POST 

Power-On Self Test 
 

PXE 
Preboot Execution Environment 

 

QFE 
quick fix engineering 
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RBSU 

ROM-Based Setup Utility 
 

RDC 

remote desktop connection 
 

RGS 

remote graphics software 
 

RIS 

reserve information sector 
 

SAM 
Session Allocation Manager 

 

SAS 
serial attached SCSI 

 

SATA 
serial ATA 

 

SIM 
Systems Insight Manager 

 

SMASH 

System Management Architecture for Server Hardware 
 

SMB 

Server Message Block 
 

SMH 

System Management Homepage 
 

SNMP 

Simple Network Management Protocol 
 

SQL 
structured query language 

 

TFTP 
Trivial File Transfer Protocol 
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UID 

unit identification 
 

USB 

universal serial bus 
 

VLAN 

virtual local-area network 
 

WOL 

Wake-on LAN 



 

Index 64 

A 
accessing iLO 2   50 
adjusting the volume   47 
Admin mode   8 
application, installation   15, 22 
audio volume   47 

B 
Basic Input/Output System (BIOS)   58, 59 
BIOS (Basic Input/Output System)   58, 59 
BIOS programming   59 
BIOS Serial Console   58 
booting the workstation   10, 53 

C 
capturing workstation blade image   27 
client to blade connection   43 
configuration, network   13 
configuration, operating system   20 
configuring workstation blade hardware   11 
connecting media to workstation blade   12 
connection, client to blade   43 
contacting technical support   6 
create custom image Windows®   17 
creating custom Windows® XP image   17, 18 
creating Windows® XP image   18 
Ctrl-Alt-Del, sending remotely   45 

D 
deploy Windows image   22 
desktop, viewing   26 
disconnecting from a workstation blade   48 

E 
Enterprise Directory, using   43 

H 
Help tab   57 
HP Insight Diagnostics   54, 55, 56, 57, 58 
HP Insight Diagnostics, downloading   58 

HP Insight Diagnostics, saving and printing   57 
HP Rapid Deployment Pack (RDP)   53 
HP Systems Insight Manager   52 

I 
iLO (Integrated Lights-Out)   13 
iLO 2 (Integrated Lights-Out 2)   50, 51 
iLO 2 link LED   13 
iLO 2 Remote Console   50 
iLO 2 virtual media   51 
iLO network   13 
Insight Diagnostics   54, 55, 56, 57, 58 
installation   10 
installation and configuration   10 
installation preparation   11 
installing applications   15, 22 
introduction   6 

L 
local directory access   44 
Log tab   57 

M 
managing workstation blades   49 
manual entry   44 
maximizing a window to single display   46 
Mode, admin   8 
Mode, remote console   8 
Mode, setup   9 
Mode, user   8 
monitors, spanning   45, 46 
moving desktop windows between monitors   46 

N 
network, configuring   13 
networking, verifying   13 
NIC configuration   13 

O 
Onboard Administrator   49 
OOBE   13 

Index 
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operating system configuration   20 
Out of box experience   13 
overview   6 

P 
PDA synchronization   47 
powering on the workstation   10, 12 
powering up   42 
Power-On Self Test (POST)   58 
preparing for installation   11 
process, creating custom Windows® XP-32 

image   17 

R 
RDP (Rapid Deployment Pack)   27, 53 
reconnecting to disconnected sessions   48 
remote access   45 
remote console   8 
Remote console mode   8 
Remote Desktop   51 
required components   17 
required software   18 
RGS (Remote Graphics Software)   14 
RGS, changing behavior   42 
RGS, NIC binding order   14 
RGS, user mode   14 
RGS, verify operation   15 
Rip-n-replace   54 
ROM-Based Setup Utility (RBSU)   58 

S 
Setup mode   9 
sleep states   12 
spanning monitors   46 
Status tab   56 
supported USB devices   47 
Survey tab   55 
synchronize a pda   47 
System Management Homepage   51, 52 

T 
technical support   6 
Test tab   56 

U 
unattended installation   33 
USB devices   47 
user information   42 

User mode   8 

V 
validating the solution   16 
validating the workstation blade   10 
video controller   7 
video subsystem   7 
virtual bay   54 
volume adjustment   47 

W 
Windows image deployment   22 
Windows Vista® desktop, viewing   26, 50 
Windows Vista® on workstation blade   25 
Windows Vista®, acquiring   25 
Windows Vista®, installing   25 
Windows® XP-32, create custom image   17 
Windows® XP-64 on workstation blade   23 
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